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Fourth Edition
First Printing
Copyright 1992 SunRize Industries. All rights reserved.

Reproduction or publication of this document in any manner, without the express written consent of the
publisher, is prohibited. No liability is assumed with respect to the use of the information herein.

The Studio 16 software is copyrighted 1992 SunRize Industries. Studio 16 may be copied for archival
purposes only.

Studio 16 is a trademark of SunRize Industries.

Your AD516 or AD1012 hardware is warranted to the original purchaser for a period of one (1) year from
the original purchase date--under normal use and service--against defective materials or workmanship.
ANY IMPLIED WARRANTIES ARE ALSO LIMITED TO THE ONE YEAR PERIOD FROM THE
ORIGINAL PURCHASE DATE. This warranty is void if the AD516 or AD1012 has been damaged by
accident or unreasonable use, neglect, improper service or other causes not arising out of defects in
material or workmanship.

SUNRIZE INDUSTRIES SHALL NOT BE LIABLE FOR LOSS OF USE OF STUDIO 16 / AD516 OR
STUDIO 16 / AD1012 OR OTHER INCIDENTAL OR CONSEQUENTIAL COSTS, EXPENSE OR
DAMAGES INCURRED BY THE PURCHASER.

During the above one-year period, defective parts will be repaired, adjusted and/or replaced (at
Manufacturer's option) without charge to the purchaser when the AD516 or AD1012 is returned, prepaid
and insured, with proof-of-purchase date, to SunRize Industries customer service listed below. UNITS
RETURNED WITHOUT PROOF-OF-PURCHASE DATE OR REPAIR FEE WILL NOT BE REPAIRED.

Before returning your AD516 or AD1012 for service, please review the service instructions in this
manual.

SunRize Industries

2959 S. Winchester Blvd., Suite 204
Campbell, CA 95008 USA

Tel: (408) 374-4962

Fax: (408) 374-4963

FCC Regulations

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC Rules.
These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment
generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause
harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

Reorient or relocate the receiving antenna.

Increase the separation between the equipment and receiver.

Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
Consult the dealer or an experienced radio/TV technician for help.

Note: Use of shielded audio cables is required to comply with the class B limits in Subpart J of Part 15 of FCC Rules.
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Introduction

Studio 16 software, when combined with either the AD516 or AD1012 audio card, becomes an advanced
hard disk recording system. Both the AD516 and the AD1012 audio card plugs into your Amiga
2000/3000 and adds audio in, audio out, and SMPTE in to your computer. They both include a sound
coprocessor (a DSP) as well as high fidelity recording and playback circuitry. The AD516 and AD1012
record audio direct to disk and play back multiple channels direct from disk.

The AD516 is a 16 bit stereo card that suitable for professional Video and CD mastering, the advanced
circuitry enables it to playback up to eight channels simultaneously. And the internal SMPTE time code
reader allows it to create extensive Cue Lists of sample to trigger to a Video tape. The more economical
ADI1012 is a 12 bit mono board that includes the same SMPTE support as the 16 bit card and is ideal for
video applications. See Appendix B for complete specifications for the AD516 and AD1012.

Included with both the AD516 and AD1012 is the Studio 16 recording and editing software. When
combined with an audio card, Studio 16 allows you to record very long sounds directly to your hard disk.
Studio 16 allows you to edit and mix sounds.

About this Manual

This manual provides information for installing and using Studio 16. This manual is divided into nine
Chapters and a detailed Reference Section. An Appendix and Index is also included.

Chapter 1.......cccooevveiiiiviieieie, Digital Audio describes the digital sampling process and explains the
difference between 8, 12, and 16 bit audio.

Chapter2...........oooeeiviieiiieeee, Installation explains how to install the AD516 and AD1012 in a
computer and install Studio 16 on a hard drive.

Chapter 3........cccooiiiiiiiiii Getting Started includes a brief introduction to sampling, playing,
editing, and an overview of common screen elements.

Chapter4..........cccoovvivivieinenne Hard Disk Drives provides information on required hard disk
specifications, and optional storage devices.

Chapter S........coovvivieeee SMPTE includes an introduction to the SMPTE Time Code Standard
and suggestions for SMPTE applications.



Chapter 6..........ccocevvevvereeeeee,

Chapter 7.......ccooeviiineniiinee,

Chapter 8.........cccoovvevveniinrieee

Module Reference .......................

Appendix A ...

Appendix B.........ccooooiiiii

Appendix C......coooevvieviiiiiiinne.

Appendix D ...

Appendix E........o.oooiiiiiin

Index

Cue List Tutorial provides step by step instructions to set up and ‘
trigger a collection of samples from SMPTE time code.

Trouble Shooting lists common problems that may be encountered
while working with Studio 16 and their solutions.

Third Party Sources includes a list of suppliers for SMPTE
converters, Sound Effect Libraries and similar products that enhance
the Studio 16 system.

Provides detailed explanation and instructions for Studio 16 Modules.

Technical Support instructs users on obtaining technical support if it
is required.

Hardware Specifications details the AD516 and AD1012.

Bars & Pipes Professional describes the Blue Ribbon Sound Works
tools and accessories that integrate Studio 16 with their MIDI
Sequencer.

Professional Audio-for-Video Application written by Qistein
Boassen of Sound Factory, Norway, details his professional audio suite
and applications for Studio 16.

Consumer Audio-for-Video Application written by Rob Grant of ‘
Video InfoCom, details his video suite setup and his audio-for-video
application for Studio 16.




Chapter 1

Introduction to Digital Audio

In recent years, digital audio has become increasingly popular. The most common use of digital audio are
currently Compact Discs and Digital Audio Tapes. DATs are replacing analog tapes for professional
audio use, just like CDs have replaced LPs for personal use.

Digital vs. Analog

Both CDs and DATSs record numbers instead of analog signals. For example, a standard cassette tape
records sound by magnetizing a tape. When the sound being recorded gets louder, the tape recorder
writes a stronger magnetic field to the tape. When the sound gets softer, the tape player writes a softer
magnetic field onto the tape. A DAT recorder, on the other hand, records numbers. For loud sounds, it
writes a large number; for soft sounds, it writes a smaller number.

There are several reasons why numbers are better to record than analog signals (such as the magnetic
signal on cassette tapes). For starters, it is much simpler to edit digital sound. Using a computer program
like Studio 16, it is easy to move parts of sound around or insert one sound into the middle of another. In
the analog world this is accomplished by cutting and splicing tape. Another advantage, and the reason the
music industry is concerned about DAT, is that when you copy digital audio you always get a perfect copy.
Remember that digital sound is just numbers and is manipulated like any other data in your computer.
When you copy a disk with your computer, you get an exact copy of the data. On the other hand, every
time you copy a magnetic tape, you add a little distortion or "tape hiss".

Converting Analog to Digital

So how do you turn natural analog sound into numbers? You need a sound digitizer like the AD516 or
ADI1012. The AD516 and AD1012 measure and record the amplitude of a sound. Amplitude is the
loudness of a sound signal at an exact moment in time. The process of measuring and recording is
referred to as "taking a sample". To digitize a sound, the AD516 (or AD1012) takes a series of samples.
It takes a sample, allows a certain amount of time pass, takes another sample, allows the same amount of
time pass, takes a sample, etc. As the samples are taken, loud sounds are recorded as larger numbers and
quiet sounds are represented by smaller numbers. The amount of time that passes between samples is
referred to as the period. See Figure 1-1. Assume the period is 1/44,100 of a second. By inverting the



period you can calculate the resulting sampling rate. The inverse of 1/44,100 is 44,100. The sampling
rate is 44,100Hz. ‘
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Figure 1-1. Digital Audio Diagram

There is a direct relationship between sampling rate and the maximum frequency you can record. This
relationship, called the "Nyquist theorem", states that the maximum frequency you can record is equal to
half the sampling rate. So, if you sample at 10,000Hz, all frequencies up to 5,000Hz are recorded
accurately. Frequencies over 5,000Hz will introduce distortion into the sound. This distortion is called
"aliasing".

Compact Discs always play back at 44,100Hz. This gives CDs a maximum frequency range of 22,000Hz
which is outside or on the limits of most people's hearing ability. The AD1012, SunRize's 12 bit audio
card can sample up to 80,000Hz, although there is no normal reason to sample this fast.

The second parameter that determines digital sound quality is the maximum sample value. If we let
silence be recorded as zero, what value does the loudest possible sound have? This value is the maximum
sample value. Sound will oscillate above and below zero by this amount. Using the Amiga's internal 8 bit
sound, the maximum sample value is 127. Thus all sounds are recorded as numbers between 127 and -
127, with zero being silence. For comparison, the AD1012 has a range of +2,048 to -2,048, Obviously
this gives the AD1012 much better sound quality than the Amiga's internal sound. Note that the sixteen
bit AD516 has an even larger range of +32,767 to -32,767.

The final thing to notice about digital sound is that it uses quite a bit of memory. Since each AD516 and
AD1012 sample takes two bytes, a sampling rate of 44,100 samples per second means that every second of
sound is going to take exactly 88,200 bytes. This works out to 5.05 megabytes per minute or 12 seconds

per megabyte.
Differences between 8,12 and 16 bit Audio

Digital sound systems generally fall into three different categories: 8, 12, and 16 bit. A small discussion
of each class follows. A common reference is given (i.e., "8 bit sounds like an AM radio") as well as the
theoretical Signal-to-Noise Ratio (SNR). Keep in mind that the SNR given is the theoretical maximum
for a pure sine wave. Practical systems never match this number. However, one aspect of the quality of a
real world system is how closely its SNR comes to the theoretical maximum.

8 Bit

The Amiga's internal sound format and SunRize's 'Perfect Sound' are 8 bit. Another common use for 8 bit

digital audio is long distance phone calls. Phone calls are often digitized with 8 bits of resolution at the

switching station for broadcast via satellite or fiber optic cable. Eight bit audio has a theoretical

maximum SNR of -48dBs and its sound quality is often compared to AM Radio. .




12 Bit

The AD1012 card is 12 bit. Twelve bit audio is also used in many popular music synthesizers. It has a
theoretical maximum SNR of -72dBs. Its quality is comparable to a high quality reel-to-reel tape deck or
FM radio.

16 Bit
The ADS16 card from SunRize is 16 bit. Compact Disk players and DATSs are also 16 bits. Sixteen bit
digital audio has a theoretical maximum SNR of -96dBs. Its quality is equivalent to a CD player.

Decibels

In audio systems the common measurement of volume is the Decibel (dB). Studio 16 volumes are also
specified in dBs. Decibels are a logarithmic scale used to more accurately represent how the ear hears
volume changes. Zero dB means no gain. Attenuation are negative, and amplifications are positive.

For example:

-12dB is equivalent to 25% volume

-6dB is equivalent to 50% volume
0dB is equivalent to 100% volume
+6dB is equivalent to 200% volume

These ratios are determined by the following equation:

dB =-20 log (gain)
e.g. -6 =-201log (0.5)






Chapter 2

Installation

Hardware Installation

The following installation instructions are the same for the AD516 and the AD1012. Both audio cards
plug into a free zorro slot in an Amiga 2000 or 3000. Installing the card is relatively simple. However,
if you prefer, your local Amiga dealer can install it for you.

Install the card

1. Turn off your computer.

2. Unplug the mouse, keyboard, monitor and power cables.

3. Remove the 5 screws securing the case. (2 on each side, 1 in the back, top-center)

4. Carefully slide the case off the computer. For more information on removing your Amiga's
case, se¢ your Amiga's Manual.

5. Identify the Zorro slots in your computer by referring to your Amiga's Manual. Zorro slots
are also referred to as "Amiga 100 pin expansion slots". (Note that any slot in the A2000 or
A3000 that the AD516 or AD1012 will fit into is a Zorro slot.)

6. Choose a Zorro slot to receive the card and remove its cover plate (back bracket).

7. Ground yourself by touching your Amiga's metal power supply case. This will remove any
static charge built up on your body.

8. Remove the AD516 or AD1012 card from its anti-static bag and plug it into the free Zorro

slot.



Note: When the card is installed properly, only a small amount of the gold connector will
show. If the slot has never been used, it may take a lot of effort to push the card in. A
gentle rocking motion is usually best.

9. Screw the card's bracket into the Amiga with the screw you removed from the cover plate.
10. Before you replace the case, record your card's serial number on your Registration Form.

11. Replace the case and secure it with the five screws.

Setting Jumpers

AD516 has one jumper. It is indicated by JP1 on the pc board. The AD1012 has two jumpers -
indicated by JP1 and JP2. All jumpers are set at the factory and shouldn't need changing.

AD516 JP1 should be set to 6. It selects interrupt 2 or 6.

ADI1012 JP1 should be set to 6. It selects interrupt 2 or 6.
JP2 should be in place for normal operation.

Connecting Audio and SMPTE

All five jacks are "consumer line level" unbalanced connections. They should be connected to an
appropriate source using standard RCA patch cables. For example, connect the left and right "Line Out"
on your CD player to the "L - IN" and "R- IN" on the AD516.

Many professional Video Tape Recorders (VTRs) use "balanced" type connections. These will typically
have the three pin XLR connectors. If your equipment uses these connectors, you will need to use XLR-
to-RCA adapters. These can be purchased at a local electronics store.

The notations on the AD516's and AD1012's brackets follows in figure 2-1.
AD516 AD1012

Oswmrre Oswrte
@”—|

IN

® ) O IN
@”:UT QO our

®

Figure 2-1. Bracket Labels

ADS16

The ADS516 card has five RCA jacks: SMPTE (LTC) In, Left and Right Audio In, and Left and
Right Audio Out.




‘ AD1012
The AD1012, a monophonic card, has the same SMPTE LTC input as the AD516. Its Audio In
and Out are standard unbalanced RCA connectors. If you are recording from a stereo source you
should record both channels and then later mix them using Transport. Using a "y" connector is
not generally recommended.

SMPTE Sources
Although Studio 16 doesn't require an external SMPTE source to run, it is enhanced by the
addition. If your deck has a dedicated LTC SMPTE track, simply connect it to the AD516's or
ADI1012's SMPTE In. Ifyour VTR does not have a dedicated SMPTE track, you can record LTC
time code to an unused audio track. Then your SMPTE out will be one of the Audio outs on your
deck. For more information on time code, see Chapter 5 -SMPTE.
If your deck uses VITC SMPTE, the SMPTE out on your deck may require a VITC-to-LTC
converter. The AD516 and AD1012 do not read "vertical interval time code" (VITC) directly.
See Chapter 8 - Third Party Sources for a VITC-to-LTC converter supplier. For information on
time code see Chapter 5 - SMPTE.

The AD516 and AD1012 SMPTE reader is designed to handle normal speed variations due to
tape motor variance. It is not designed to read time code in "fast forward" modes.

Software Installation

‘ Install Studio 16 on a Hard Drive
1. Turn on your computer and wait for WorkBench to finish loading.
2. Insert the Studio 16 Disk 1 into a floppy drive.
3. Double click its disk icon.

4. Double click the Read_Me icon. The read_me file contains information that was not
included in this manual. It may include information related to installation.

5. Double click the Install. HD icon.

6. The installation program will run. Figure 2 - 2.

Note: The install program is equipped with on line help and a status line for your
convenience.

7. Select the hard drive or partition to put the Studio 16 program on. Your available Amiga
DOS devices will appear in the upper left window. Studio 16 must be installed in the root
directory of a device, not a sub directory. Click one of the names to select the device. (You
do not have to use the same path that you intend to use for your audio files.)

8. Click on the large Begin Install button.

9. The installation program will create a directory called 'Studiol6' and copy the appropriate
' files into it. In addition, your s: and libs: directories will be altered.



10. Insert the Studio 16 Disk 2 when indicated.
11. The installation is complete when an Installation Complete Requester appears.

12. Click OK and close the installation window.

Figure 2-2. Studio 16's Install Program

Load Studio 16

Studio 16 will run under WorkBench 1.3 or 2.0. You can load Studio 16 from the either WorkBench or
the Shell.

From WorkBench -
Double click the Studio16 directory icon.
Double click the Studio16 program icon.

From the Shell -
Change the current directory to Studiol6.
Type studiolé.

Running Studio 16 before partitioning your hard drive

Because Studio 16 is very hard disk read/write intensive, it is very important to create a partition on your
hard drive dedicated to your working audio files. If you've just received your AD516 or AD1012, and
would like to try it out before you backup and partition your hard drive, you can safely run Studio 16 by
recording into memory. When Studio 16 is first installed it will set your record path RAM:. This means
that all recordings will be made directly to your memory - not to your hard drive. Check the Open List for
your record path. It is indicated by a [X] next to a path name. Make sure RAM: is the selected record path
if you have not partitioned your hard drive.




Partitioning your hard disk

Studio 16 can use any Amiga DOS device to record and playback from, (i.e. DFO:, DHO:, RAM:, etc.).
And, unless you are recording to RAM:, Studio 16 is very hard disk read/write intensive. Therefore, it is
very strongly recommended that you create a separate partition on your hard disk for your audio files you
are recording, editing, and playing. If your Amiga crashes while a write is in progress, you may have to
reformat your hard disk. If you have partitioned your hard disk and a crash occurs, you will only lose your
"working" audio partition. You will not lose anything valuable, i.e. programs and archived samples.

|§Iote: SunRize is not responsible for data lost due to crashed hard disks. Partition your hard drive!

If you are working with a single hard disk, it is a good idea to turn "Reselection" OFF. For instructions on
partitioning your hard disk, refer to your hard disk controller manual. If you are using more than one
Hard Disk, you should have "Reselection” ON. (Reselection is an option available in your partitioning
program.)

When naming your Audio partition. Do not name it Studiol6. This will confuse the system since there is
a Studio 16 assign. Tutorials in this manual will refer to the partition as if it were named "Audio”. You
may want to name yours "Audio" as well.

Set your Record Path

A Record Path is the assigned location for your new audio recordings. The default path is RAM:. Once
you have partitioned your hard disk, you will want to change the record path to a directory on the hard
disk. Your record path should be located on your Audio partition.

The following changes the record path from RAM: to a directory on the hard disk.
1. Select Open List from the Applications Menu (*O).

2. The Open List appears with RAM: showing and selected as the record path, note the
selection box [X] next to the path name.

3. To add another path to Open List, select Add New Path from the Open List menu. Select
your new path from the requester and click OK.

4. Open List will update and display the two directories. You can continue adding paths (up to
cight) to suit your setup. Remove the RAM: path by selecting Remove Path from the Open
List menu and selecting it in the requester.

5. Once you have all your paths listed, choose one for the record path by clicking the active box
[X] next to its name. You can change this selection at any time.

6. To save the Open List setup, select Save Preferences from Project menu. This will also save
the positions of the windows on the screen. If you don't want Open List showing every time
you run Studio 16, close Open List before you SaveSetup.



Studio 16 File Structure ‘

Studio 16 requires the following directories of files to operate. They are automatically copied by the
Install program into a Studiol6 directory.

Applications
Drivers
Utilities
ProjectMenu

The Studio 16 Install program also places the following files in your libs: directory.

Gadlib.library
Interface.library
Studio.library

Studio 16 should have an assign called "Studiol6:" that points to the created Studio 16 directory. The
install program automatically creates a file called "s:Studiol6Path.config" (an ASCII file that contains the
path to the created Studio 16 directory). Unless you issue an assign statement in the Shell or your
s:startup-sequence, Studio 16 will issue one the first time it's run based on the "s:Studiol6Path.config"
file. Therefore, if you move the Studio 16 directory after you have installed Studio 16, you must create a
Studio16: assignment that points to the new location.

10



Chapter 3

Getting Started

This chapter is a brief tutorial on using basic Studio 16 options. Included is description of common screen
elements and short tutorials to record, play, and edit a sample. Detailed information on all modules is
provided in the Reference Section of this manual.

It is recommend that you open and read the Read_Mae file on Disk 1 before loading Studio 16. The file
includes updated information that is not in this manual.

Load Studio 16

1. Double click the Studio16 icon in the Studio16 drawer. For more detailed instructions see
Chapter 1 - Installation.

2. An About window will appear listing the default record path and free disk space. Click OK
to close it.

Menus and Keyboard Shortcuts

Studio 16 Modules can be launched from the Applications Menu, from the keyboard, or from the Instance
List. To select a module from a menu, click the right mouse button and hold it down. Move the mouse
pointer over a menu option and release the mouse button to select it.

Keyboard shortcuts are identified in the menu to the right of the option name. Module shortcuts use the

control (Ctrl) key, indicated by( * ). All other keyboard shortcuts will use the Right Amiga Key( 4- ).

To use a keyboard shortcut, hold down either the Control key or the Right Amiga key, and type the letter
indicated.

The key to using software efficiently is to memorize the keyboard shortcuts for your most common
applications.

11



Once a Module is launched it may add more menus to the menu bar. For a module's menu options to be
available and to use its keyboard shortcuts, you must first make the window active by clicking on it. The .
title bar of a window will be highlighted when it is active.

NOTE: OK requesters can generally be accepted or rejected with the standard keyboard shortcuts.
For OK, Left A-V. For Cancel, Left A-B.

Common Screen Elements

Most screen elements are common to the Amiga Intuition standard; however, there are a few gadgets that
you may not be familiar with.

Drop List - Indicated by a ¥, allows you access to available choices for an option. Click the ¥ button
for a list to appear below the current selection. Use the familiar scroll bar and arrow buttons to locate a
new selection. Click on an item to select it.

Active Boxes - Many options can be turned on by activating them. Click the active box next to the
option's label, [X]. Deactivate it by clicking the button a second time or by selecting an other option.

Minimize/Maximize - Found in the title bar. Click this button to reduce a window to its smallest possible
dimensions. Click the button again to enlarge the window to its previous dimensions and location.

Depth - Located in the top right corner of all windows, the Depth button allows you to bring a window to
the front or move it to the back. Click the button once to move it to the front. If the window is already in
front, the single click will move it to the back or underneath all other windows. Also selecting a module
from the Applications Menu will bring it to the front. If ClicktoFront is selected in Preferences, this
button will not appear. Windows are then brought to the front by clicking anywhere on them.

Resize - In the lower right side of most windows is a small triangle. Click and drag this triangle to resize
a window. As windows are reduced in size, text in the window and title bar will be truncated.

Record and Play

Once you have installed and loaded Studio 16 you are almost ready to record.

Before you can record, you need to connect your audio source. Any audio source with a "Line Out" may
be used, preferably a CD player. Use a short RCA patch cable to hook up the CD's Line Out to the board's
Audio IN jack(s). If your audio input is from a microphone, you will need an external device, like a
mixer, to turn the mic output into an RCA Line Out. The card's Audio OUT jack(s) can be hooked up to
a receiver or an amplifier system's CD/AUX Line In. If you have a LTC SMPTE time code source, plug
it into the top jack: SMPTE IN.

Now that you are ready to record, there are two methods of recording. One uses the Recorder module and
the other records from Transport.
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‘ Record & Play a Sound - METHOD 1, using Recorder and Open List

Record with Recorder

1.

Load Recorder, Open List and Meters from the Applications Menu. Close any other modules
that are open. Figure 3-1.

Check your record path in Open List. If you have not partitioned your hard drive, it should
be set to RAM:. (The record path is identified by [X1.)

Turn on your audio source.

Click Monitor in the Recorder window. You should hear the audio playing through your
output device.

ADS16 ONLY - To make a sterco recording, select the L and R channel from the Recorder
Menu so that both channels have a v next to them. Make sure you have audio connected to
both the AD516's audio inputs.

Activate Meters clicking by on the window. From the Channels Menu, select the Input,
Output and Play 1. These are easily selecting by holding down the right mouse button, and
clicking the channels with the left mouse button. You will now see activity on the input and
output meters.

-— RECORDING —- =3 Meter Window 2

1> Untitled R ADS16 Input AD516 Play 1 AD516 Output

Recorder - ADODI. e ey

Figure 3-1. Recorder and Meters

Set the proper Gain setting by watching the meters for clipping. Clipping results from the
gain being set too high. It is indicated on the meters by the VU meter going into the (+)
section, the LED meter flashing on the far right side, and the scrolling graph meter peaking
off the top and bottom. Adjust the Gain so that clipping rarely, if ever, occurs. Figure 3-1.
See the Meter Reference Section for more information.

ADS516 ONLY - Sterco samples will be shown in the scrolling meter by channel. The input
from the left channel will be graphed on the top of the graph, and the input from the right
channel will be graphed on the bottom of the graph. Disconnect one of the inputs to see the
effect on the scrolling graph.
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10.

11.

12.

13.

AD1012 ONLY - ADI1012 owners have the added option of setting a variable lowpass
filter. Activate Auto Filter to set an appropriate cutoff filter for your sampling rate. (The ‘
ADS516 has a digital filter. It's automatically activated whenever you record.)

Select a sampling Rate. Keep in mind that 48KHz is the standard rate for DAT players.
Anything more than this is wasting memory. For video purposes you may want to record at
about 30,000Hz. This gives a 15KHz frequency response, more than adequate for narration
and sound effects. (The nearest available sampling rate for the AD516 is 32,000Hz, the
AD1012 can record at 30,120Hz.)

Click the Name button and type in a name for your sample. The default is Untitled.

Note: You can name the sound before you start recording, or you can rename the sample in
the Open List later.

To begin recording, click Record. A window will appear in the middle of the screen
indicating that recording is in progress, Figure 3-2. Also displayed is the name(s), the size of
the sample recorded so far, and the remaining disk space. These numbers will change as the
record proceeds. And, unless you're recording to RAM, your hard disk light will flash.

~ -— RECORDING
1) Untitled_R
[2) Untitled_ L
Size: 8.251M

Lef t: 2.288M
StartTine 88:688:15:18

Figure 3-2. Recorder's Progress Indicator

If you have SMPTE time code plugged into the AD516 or AD1012, the recorder will show
the time your recording began. Later, if this sample is loaded into the Editor or the Cue List,
this SMPTE time code will enter itself with the sample.

To stop recording, click the Stop button. If you continue to hear sound, it is the monitoring
of the audio source. Click the Monitor button to stop monitoring. The "monitor" and
"record” functions are independent. Also, your hard disk light may continue to flash for a
few seconds after selecting stop. This is normal.

Play from Open List

There are a few ways to play back a sample. To play back from Open List:

1.

Launch Open List from the Applications Menu, (* O). Figure 3-3. (You can close any other
modules that are open.)

Select the sample you recorded earlier by clicking on its name. It will be in the active
directory. The active directory, or record path, is indicated by .

ADS16 ONLY - To playback a stereo sample, you need to select both the samples that were

recorded, (e.g. Untitled_L and Untitled_R). Select both samples by shift-clicking.
(Holding down the shift key while clicking on multiple sample names.) '
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. 4. Play the sample(s) by selecting Play Sample from the Open List menu or by typing 4-P.

5. To stop the playback early, select Stop Playback, 4-S.

Note: When playing back multiple samples, all samples must have the same sampling rate. —I

[~ Open List ___]_ci]-—

Figure 3-3. Open List

Record a Sound - METHOD 2, using Transport

‘ You can also record and playback from within the Transport module. The benefits to this method are that
you can record the output of the card allowing you to mix sounds together, and you can play sounds while
recording. The following tutorial makes a simple recording from the input and then plays it back.

Record from Transport

1. Verify your Record Path in Open List. If you have not partitioned your hard drive, the
record path should be set to RAM:, (indicated by [XI).

2. Launch Transport and Mixer from the Applications Menu. Close all other modules that may
be open. Figure 3-4.

3. Turn on your audio source.

4. Monitor your input by raising the input level on the Mixer. You should hear the audio
playing.

5. In Transport, the sampling rate and gain level are set from Handler in the Options Menu.
Similar to Method 1, set an appropriate Gain, sampling Rate. AD1012 users should also
select a Filter setting. Then click Exit. You may want to load Meters to adjust the Gain.

6. In Transport, activate a record track (IXI) and type in a name for the recording, the default
name is Untitled.

7. ADS516 ONLY - To make a stereo recording, activate both record tracks (IXI) and enter
names for both channels, (e.g., Untitled_L and Untitled_R).
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Eduntitled L [
Eduntitled R |

Figure 3-4. Transport and Mixer Modules
8. Click Record then Play. Both buttons must be depressed to begin recording.

9. Click Stop to end the recording.

10. Stop monitoring by decreasing the input volume in the Mixer to -co. (-00dBs)
11. Your new sample(s) will now be listed in Open List.

Play from Transport
1. Launch Open List from the Applications Menu, (* O).

2. Drag your sample(s) from Open List into Transport and drop it in a playback track at the top
of the window.

3. ADS16 ONLY - To playback a stereo sample, both samples must be played simultaneously.
So, drag both samples, (e.g. Untitled _L and Untitled_R ) into the Transport playback tracks.

4. Select Play in Transport (4-P).
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‘ Edit a Sample

To make changes to a sample, it must be loaded in an editor. This part of the tutorial covers basic
navigation within the editor and use of the non-destructive cut, copy and paste.

Load a Sample Editor
1. Load Open List from the Applications Menu (* O).

2. Select the sample you want to edit and select Edit Sample from the Open List Menu or type
A-E.

3. ADS16 ONLY - To edit a stereo sample, select two samples in the Open List (ending in _L
and _R) by shift-clicking and then select Edit Sample (4-E)

4. An Edit window will appear with your sample(s) graphed. Figure 3-5.

5. Select Play All from the Editor Menu to hear the sample (4-P). The keyboard shortcut A-P
is one the most useful short cuts, it causes samples to play in many of the modules.

Copy a Range and Duplicate it within the Sample
1. Mark a range over the area of the graph you want to duplicate. To mark a range, click on
the graph and drag the pointer to the left or right. To alter the size of an existing range,
‘ click on one edge of the range and drag it to a new location.

2. Select Play Range from the Editor Menu (4-L) to hear the marked range. Figure 3-5.

Spirit:Samples/GTair_Lick

Figure 3-5. Edit Window
3. Select Non-Destructive Copy from the Edit Menu.

4. Click on the graph to select an insertion point for the copied range.
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5. Select Non-Destructive Paste, and Insert at Start, (4-V). (Start refers the beginning of the
marked range. When you just click on the graph, you create a very small range.) .

6. Click Play All to hear the new version of the sample. Undo will return the sample to its
previous state.

Note: Because the previous copy and paste were Non-Destructive edits, Undo is able to
cancel the change. Destructive edits are not undoable. Having a choice between
destructive and non-destructive editing allows you to have more control over your
samples. Destructive editing actually changes the data on your hard drive as you alter
a sample in the editor. However, Non-destructive edits do not destroy any data on
your hard drive. It just remembers which edits you want to perform on the sample.
Non-destructive edits can be made permanent and free hard disk space by selecting
Make Permanent. See the Reference Section on the Editor for more information.

Delete a Range
1. Mark a range to delete using the previous technique.
2. Select Non Destructive Delete from the Edit Menu, (4-D). Since the delete is non-

destructive, it will not remove data from your hard disk. To free hard disk space, use the
destructive delete or select Make Permanent after doing the non-destructive delete.

Create a Region

Regions are named ranges within samples. Once created in the Editor, they can be dragged and ‘
dropped into the Cue List as an entry, or into Transport for playback.

1. In the Editor, select a range to be named as a region. For details on marking ranges refer to
the technique mentioned previously in this section.

2. From the Options Menu, activate Show Regions. An Editor Regions List will appear,
Figure 3-6.

3.  When the Editor Regions List is active, a Region Menu is available in the Menu bar.

4. Select Add Region from the Region Menu to create a region from the marked range in the
Editor.

Figure 3-6. Editor Regions List
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o .

When prompted, enter a name for the region.

You can now drag this region into Transport or Cue List for playback. (Regions can also be
dragged from the Open List when Show Regions is activated from the Open List menu.)

Convert a Sample

When a sample is recorded it is usually stored in the Studiol6 2.0 file format. This default format is
selected in Preferences from the Project Menu. Studiol6é 2.0, like AIFF, is a 16 bit format. It includes
special data that keeps track of non-destructive edits and marked regions. To export a sample to another
audio program you will probably have to convert to another file format. Studio 16 will convert to: AIFF,
IFF 8SVX, RAW, CDTV RAW. Below are the steps to convert a sample to an IFF-8SVX format.

1.

2.

8.

Load Open List from the Applications Menu.

Select a Sample to Convert.

Select Convert from the Open List Menu.

Select IFF-8SVX for the file format. Figure 3-7.

Click OK.

A Save File Requester will appear. Enter a directory and file name for the new 8 bit sample.

Click OK.

Select File Fornat:

Figure 3-7. Convert Sample

You can still load this new file into Studio 16, but because converting a 16 bit sample to an 8
bit format drops bits, the sample won't sound as good as it did before the conversion.

9. The original 16 bit sample is still on disk. You can delete it from Open List.

Note: See the Reference Section on Open List for a description of the available file formats and

more detailed instructions on converting.

Converting files to IFF 8SVX can be especially useful if you need to conserve disk space and you're
‘ working with samples that don't require a high SNR. Sound effects like explosions will likely sound the
same whether they're 8 bit or 16 bit files. Both 8 and 16 bit files can play simultaneously, if they have the
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same sampling rate. Plus, the 8 bit file will only take up half of the disk space it did when it was a 16 bit
file. (Note that samples recorded with the 12 bit AD1012 are stored in a 16 bit format.) ‘

Quit Studio 16

To quit Studio 16, select Quit from the Project Menu. Before clicking OK, you should check the Open
List for any samples that are in the RAM: directory. These samples should be moved to a hard disk before
turning off your Amiga; otherwise, they will be lost.

To save the position of all the open windows and their settings select Save Setup from the Project Menu
before selecting Quit.

Shell Commands

There are six shell commands included with Studio 16. These commands allow you to access Studio 16
samples and SMPTE without actually loading the program.

StudioClose
StudioOpen
StudioPlay
StudioQuery
StudioStop
StudioWait

See the Reference Section for more details on a particular command.
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Chapter 4

Hard Disk Drives

Studio 16 usually uses a hard disk to store audio files. Although it is possible to use RAM for sample
storage (add RAM: path to Open List), this is not common. Hard disks are preferred because they can
store large amounts of data relatively cheaply.

About Hard Drive Specifications

Hard disks are primarily rated by their "average seek time". This is the average time it takes the
read/write head to move between two random tracks. For example, the hard drive in an Amiga 3000 is
often an "11 ms, 105 Meg Quantum." This translates to a drive that holds 105 megabytes of data, is
manufactured by Quantum, and has an average seek time on reads of 11 milliseconds (which is quite fast).
This is a little deceiving because the Quantum drive has a track buffer that makes reads appear faster than
writes. The average write seck time on the same drive is 19 ms.

A second parameter of drives is the "data transfer rate" from the drive once the seek is completed. The
hard disk controller you use can affect this as much as the drive itself. In general, slow data transfer rates
are only important on optical drives. For example, a fast drive with an A3000 hard disk controller may
run at 1.9 MB per second. However, a typical Magneto-optical drive runs at 100K per second for writes,
and 300K per second for reads.

How fast does my hard drive need to be?

Studio 16 will work with almost any drive you can buy these days. However, the faster the better. For
example, the A3000 105 MB Quantum with an average seek time on reads of 11ms and 19 ms on writes is
fast enough for about 6 tracks at a 44.1 KHz sampling rate using the AD516.

But even slower drives will work. For example, the "SyQuest" removable media drive has an average seek
time of 26ms. It is possible to do multiple tracks with this drive. However, you may have to reduce your
sampling rate or the number of tracks you are playing back. Note that the AD516 is much more efficient
than the AD1012. As a general rule you can play more tracks at faster rates with the AD516.
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Removable Media Drives

SyQuest is a popular removable media disk drive. In testing, we found that you can play multiple tracks
off a SyQuest drive, although you may have to reduce the sampling rate or the number of simultaneous
tracks. You may also need to increase the "Channel Buffer” in Preferences.

Optical Drives

Although we haven't tested it in house, we have reports from AD1012 owners recording and playing one
channel of audio with a Ricoh 600MB magneto-optical drive. This drive has an average seek time of 33.7
ms with read and write rates of 300K/second and 100K/second respectively. In order to work, the
"Channel Buffers" in Preferences were increased to IMB. Note that performance will be improved with
the AD516.

Another user reports to playback 2 tracks with a Maxtor Tahiti IT - 1 GB magneto-optical drive using the
ADI1012 in an A3000. The access time for this drive is 90-120 ms.

For more information on the above drives, contact the manufacturers, listed in Chapter 8.

Hard Drive Space Requirements

Memory usage is entirely based on the sampling rate of a sample. The following chart provides a Meg per
Minute guide for common sampling rates when recording 16 bits. The formula used to derive the chart
is: MB = Sampling Rate x 2 x 60 sec/min + 1024byte/k + 1024k/MB. Or, more simply, 1 second of
sound = 2 x Sampling Rate.

When recording in stereo, double the space requirements listed below.

Sampling Space for 1 minute (1 track) Space for 30 minutes (1 track)
Rate (60 seconds) (1800 seconds)
11,000 1.3MB 37.8 MB
22,000 25MB 75.5 MB
32,000 3.7MB 109.8 MB
44,100 5.0MB 151.4 MB
50,000 5.7 MB 171.6 MB

Fragmented Hard Drives

As drives are used, they tend to become cluttered. The operating system starts to spread files out across
tracks that are not close to each other. As a result, it takes longer to read the files because the hard drive
must seek farther between tracks. This is called "fragmentation” and becomes a particular problem as the
hard disk becomes full. If your hard disk or audio partition is fragmented, you may have trouble playing
sounds. You can purchase programs that will "optimize" or "de-fragment” your hard disk. They scan
your hard disk and rearrange the data so that all the data for a particular file is near each other.

Disk Errors

Hard drives aren't fool proof, and it is almost inevitable that you will at some point encounter a disk error.
This can manifest itself as a "Read" or "Write" error. Or, occasionally as a "Can't Validate Drive" error.
Sometimes clicking "retry" or "cancel" on the DOS requester presenting the error will cause the error to
disappear. However, if this happens you should start to worry because the error will probably reappear
later, and can mean a failing hard drive.
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Of course your best advice is to backup your hard drives. They can be backed up to a SCSI tape drive or a
SCSI optical drive. However, due to the time and expense involved, many people don't bother. Just be
warned that a hard disk "crash” is not just a possibility, it is very likely that it will happen to you
eventually. For more information on preventing disk errors, and recovering data after a disk error, refer
to Chapter 7 - Troubleshooting.

If your hard drive crashes, and you're not sure what to do, take your Amiga to your Amiga dealer. Their
service department should be experienced in attempting to restore data from corrupt hard drives.
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Chapter 5

SMPTE

Introduction to SMPTE Time Code

SMPTE (Society of Motion Pictures Television Engineers) time code is a standard way to keep track of
time or position on tape. SMPTE (pronounced "simp-tee") time code is most common in video
production, but is also used in film and music production. In general, SMPTE time code specifies
position and timing information in terms of frames. The format is:

HH:MM:SS:FF (HOURS:MINUTES:SECONDS:FRAMES)
(01:12:06:02 refers to 1 hour, 12 minutes, 6 seconds, and 2 frames)

Time code is used to synchronize events. With Studio 16 you can specify that a sound will trigger at a
specific time code. For example, you may find that a door begins to open at exactly 1 minute, 2 seconds,
and 15 frames into your tape. You can set up Studio 16 to trigger a "door open" sound effect at
00:01:02:15 with the Cue List.

SMPTE time code is used to synchronize events in music production as well as video production. For
example, a musician with a multi-track tape recorder may want to synchronize it with a MIDI sequencer.
This can be accomplished by "striping” time code onto the multi-track, and then running the time code out
of the multi-track, and into the computer. The computer can then run a MIDI sequencer capable of
"slaving" to the tape by following the time code. Studio 16 and the Bars&Pipes sequencer allow you to
accomplish this without an external multi-track. Studio 16 can act as a digital multi-track tape deck, and
it will sync to Bars&Pipes through "internal" time code.

VITC or LTC SMPTE

There are two basic types of SMPTE time code: LTC (Longitudinal Time Code) and VITC (Vertical
Interval Time Code, pronounced "vit-see"). LTC is written on the audio track of the tape deck, and VITC
is embedded into the video signal. VITC has the advantage of being available constantly, even when the
video deck is paused. Whereas, LTC requires that the deck be playing for time code to be available.
However, LTC time code is less expensive, and works on any audio tape recorder--not just video decks.
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decks record/play heads are currently located.

Both LTC and VITC store the same basic information--the frame number that specifies where the tape '

Both the AD516 and AD1012 include a LTC SMPTE reader. If your deck outputs VITC, there are
translators available that will convert the time to LTC which is read by the AD516 or AD1012. See
Chapter 8 for a supplier.

Frame Rate

One final aspect that needs to be specified when selecting a time code format is the frame rate, or number
of frames per second. SMPTE supports the following:

24 fps Motion Pictures
25  fps European Video
29.97 fps "non-drop frame" USA color video
30  fps "non-drop frame" USA B&W video or music
30  fps "drop frame" USA color video

When SMPTE was first introduced in 1967, it was for 30 frames per second used in black and white TV.
However, when NTSC color TV was introduced, it used the slightly slower rate of 29.97 frames per
second. This is approximated in "drop frame" SMPTE by dropping 108 frames every hour. Drop frame is
used so that "real time" or "clock time" will match the time code marked on the tape. However, drop
frame can cause problems because of the missing frames. So, 29.97 non-drop frame is often used.

Striping Time Code

In order to use time code, you must first "stripe” your tape. That is, you record time code onto the entire
tape area you are planning to use. Depending on the camera or video deck you use, this may be automatic
or manual. Or, you may have a dedicated "Time Code Out" jack on your deck.

Studio 16's internal SMPTE generator does not output time code for striping.

To stripe LTC onto your tape, you will need an LTC generator. Time code generators can be part of a
video cameras or a video deck. Or, they can be dedicated generating boxes, or software programs, namely
the SunRize SMPTE Output module. Chapter 8 lists manfacturers of LTC generators.

Contact your dealer or SunRize for more information on SunRize's SMPTE Output module that outputs
LTC time code for striping tapes.

SMPTE for Video Applications

Time code is essential in any kind of professional video production. It allows precise specification of
video and audio edits. With Studio 16, you use SMPTE time code in conjunction with the Cue List to
synchronize audio effects, music, and narration with the video tape. These audio clips reside on your hard
disk until you create the final master tape. During your edit sessions, the Cue List will track your tape's
time code and trigger sound effects as specified. You will be able to listen to the audio coming off the
computer as you watch the video.

SMPTE for Music Applications

SMPTE time code was originally designed for video applications but with the success of MIDI (Musical
Instrument Digital Interface) it became apparent that it would be useful to use SMPTE time code to time
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MIDI sequencers and to communicate with other MIDI devices. MIDI quickly adopted a MIDI Time
Code format. MIDI Time Code is easily converted to SMPTE Time Code and vice versa. To drive
external MIDI equipment you may need a SMPTE to MIDI time code converter. Chapter 8 lists a source
for such a device. MIDI time code is used as a timing source for sequencers, to sync two tape decks
together or to sync a tape deck with a MIDI sequencer among other things. When Studio 16 is used along
with Bars&Pipes Professional, you get complete sequencing capabilities as well as hard disk recording.
Your MIDI sequences can have vocal tracks and guitar solos without having to use an expensive multi-
track tape deck that tracks MIDI time code. See Appendix C: Bars & Pipes for details.
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Chapter 6

Cue List Tutorial

The Cue List module allows you to trigger sounds at specific SMPTE time codes. The Cue List itself can
contain any number of entries. Each entry specifies a sample name and a time code indicating when the
sample will play. In addition, you can enter a remark for each sample. The Cue List allows you to trigger
up to eight sounds simultaneously on the AD516, and four sounds on the AD1012. (The actual number of
sounds you can play simultaneously depends on your Amiga's CPU speed and hard disk speed.)

The following Cue List tutorial is created by loading the demo sounds from the Studio16:Samples
directory into the Cue List Module along with SMPTE Start Times. The samples are then triggered by the
Internal SMPTE Generator.

The final outcome is the sound of a doorbell being rung a few times, then a door knock, followed by a
door opening and closing. Keep in mind that the demo samples were sampled at 8 bits with a very low

sampling rate in order to keep their file size small enough to fit on the floppy disk. Your samples will be
sampled with more bits and at a higher sampling rate. They will sound much better.

Add Studio16:Samples path to Open List

Before triggering any samples from the Cue List, you must make sure the samples are in the Open List.
This tutorial uses samples that are included in the Studiol6:Samples directory.

1. Load Open List from the Applications Menu, (* O).

2. Select Add New Path from the Open List Menu (4-A).

3. Select (DIR)Studio16 in the device list, and then select, then (DIR)Samples. Click OK.
4. Open List will update with Samples as a new directory containing the following files.

CloseDoor DoorBell DoorKnock OpenDoor
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5. To play the individual samples, you can click on the name and select play sample from the
Open List Menu, or type A-P. ‘

Enter Cue List Entries

Entering a Cue List can be done in two different ways. The first method is detailed below. Enter the
items by dragging sample names from the Open List or Editor Regions List. Entries can later be edited in
the edit fields at the bottom of the Cue List window. The alternative is to load your word processor and
type a list then load it into Cue List. See the Cue List Reference Section for formatting details.

SHORTCUT - The following Cue List has already been created and can be loaded by selecting Load from

the Cue List Menu. The default directory is Studio16:CueLists. Select Tutorial.List and click OK. Once
the List is loaded, you can skip the following steps and go to the next section, "Trigger the Cue List".

Entering the Tutorial Cue List

1. Load the Cue List from the Applications Menu. Open List should already be open with
following samples listed in the RAM: directory.

CloseDoor DoorBell DoorKnock OpenDoor
Click on DoorBell and drag it into the Cue List. Notice the SMPTE start and stop time will

automatically update. Cue List starts the first sample at 00:00:01:00 (1 second). The end
time is calculated from the length of the sample.

Note: To Play DoorBell , highlight the sample in the Cue List and select Play Sample from
the Cue List Menu or type 4-P. This is just like playing the sample from Open List.
To play the samples in order, you have to activate a SMPTE source. This is explained
in the next section.

3. Next, drag DoorBell into the Cue List again. And then a third time. So you have three
entries for DoorBell. The Cue List will automatically set the start times of each sample to
trigger the samples 16 frames behind one another.

4. Now drag Door Knock, Open Door and Close Door into the Cue List. You should now have
six entries in your Cue List.

5. Ifyou dragged the samples in a different order, you may have to shuffle them around to have
them look like Figure 6-1. Change the start time of an entry, by typing in the Edit Line,
will causes the Cue List to resort by start times. You can also use the menu commands Add
and Delete Entry to reorganize your list.

6. Change a start time - Highlight an entry in the list. Delete the existing start time in the edit
line at the bottom of the Cue List window. Enter in a new time, and hit return. You do not
have to type colons ":".

7. Replace an entry - You can also drag the sample in again from the Open List and drop it in
the edit line along the bottom of the Cue List to replace the selected entry.

8. Once the Cue List looks like Figure 6-1, you are ready to trigger.
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Figure 6-1. Tutorial. List

Note: In the preceding tutorial, the Volumes of the samples were not altered. To lower or
increase the volume of a sample, change the entry in the Vol field. You can also, enter
an optional remark for each sample. Select an entry and type a comment in the Remark
field. Always hit the Return key, after you alter a field. This updates the list.

ADS516 ONLY: Because the sound effects used in this tutorial were recorded in mono, they
playback on the right channel. To make the samples playback on both channels, you will
need to enter a pan statement in the remark field. See figure 6-2 for the correct format.
The Cue List reference section has more information on pan.

Trigger the Cue List

METHOD 1 - Internal SMPTE Generator
1. Load the SMPTE Generator.
2. Turn the Cue List on, by clicking the ON/OFF button.
3. Trigger the Cue List by clicking Play in the SMPTE Generator module.

4. Each sample will trigger at the appropriate time. The entry in the Cue List will be
highlighted as it is playing.

5. After all the samples have been triggered, click Stop and then Return in the SMPTE
Generator module to reset. The reset time should be 00:00:00:00.

[NOTE: To stop the triggering after it has started, simply turn the Cue List OFF. |

METHOD 2 - External SMPTE Generator

External time code will generally come from a professional VTR tape striped with SMPTE time code, or
an external SMPTE time code generator. Your external SMPTE time code source must be connected to
the AD516 or AD1012 card. The top RCA jack on the card is the SMPTE IN jack. Use an appropriate
cable to attach your external SMPTE source to the card.
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To tell Studio 16 to listen to your external time code you must:

1. Close Studio 16's SMPTE generator if it's open.
2. Turn the Cue List on, by clicking the ON/OFF button.

3. You can then trigger the Cue List by activating your external SMPTE source.

Note: It may be useful to open the SMPTE Monitor to display the SMPTE time code coming into
the AD516 or AD1012. When you start your external time code source, the SMPTE
monitor will display the incoming time code, and your Cue List will trigger.

Save a Cue List
1. To save your Cue List as a Cue List file, sclect Save As from the Cue List Menu. A Save
Cue List File Requester will appear with Studiol6:CueList as the default directory. This
directory is reserved for your Cue List Files.

2. Enter a name for the List and click OK, or hit return.

Note: Saving a Cue List saves a text files with the list of entries only. It does not save the
samples that are in Open List.

Delete a Cue List

You can delete a Cue List File from WorkBench 2.0 or from SHELL in WorkBench 1.3 or 2.0. To delete
an entry with a SHELL:

Open a SHELL from WorkBench, and typing the following.
(name should be replaced with your file's name)

cd Studiol6:Cuelists.]
dird

delete name.cue.l
endcli.l
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Chapter 7

Troubleshooting

The following symptoms and their solutions are covered in this chapter.

I.  Can't edit a sample in the Editor
II.  Can't hear input

III. Can't hear playback
‘ IV. Can't select correct sampling rate in Editor or Transport
V. Card communication errors or GetW/SendW errors
VI. Cue List won't trigger
VII. Flashing screens or skipping/repeating sound
VIIL. Full hard disks
IX. Gain won't adjust
X.  Graph doesn't match sound
XI. Hard Disk Read/Write errors
XII. Modules won't open
XIII. Playback is out of sync in Cue List or Transport

If the following recommendations do not solve your problem, call SunRize technical support for more
information.

I. Can'tload a sample in the Editor
a. Problem - The sample is being used by another module, usually Cue List.
Solution - Simply turn OFF the Cue List by clicking the ON/OFF button at the
bottom of the window, or close the Cue List window.

II. Not being able to hear input
a. Problem - Mixer level is set too low.
Solution - Open the Mixer from the Applications Menu, and set the Input and
Output Channels' volume level to +00dB.
. b. Problem - Input cables are not connected correctly. (You know this is the problem if you don't
see Meter activity on the Input channels.)
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Solution - The audio In jack(s) must be connected with an RCA patch cable to the
line out of an audio source. Make sure the audio source is turned on.

¢. Problem - Gain chip is malfunctioning -- only a possibility on the AD1012.
Solution - If you do not see activity on the input channel of the Mixer, and you're
sure your audio source is connected properly, the Digital Pot on the Gain circuit
may be bad. Especially if you can barely hear the playback, or changing the gain
level has no effect on the volume. Call SunRize technical support if you suspect
this problem.

III. Not being able to hear playback

a. Problem - Mixer level is set too low.
Solution - Open the Mixer from the Applications Menu, and set the Input and
Output Channels' volume level to +00dB.

b. Problem - Output cables are not connected correctly. (You know this is the problem if you can
see Meter activity on the Output channel.)
Solution - The audio Out jack(s) must be connected with an RCA patch cable to a
mixer or the CD/AUX input of a receiver or amplifier. Make sure the receiver is set
to CD input and is turned on, also check the speaker connections.

IV. Can't select the correct sampling rate in Editor or Transport

a. Problem - The Set Sample Parms or Handler display will not show all the rates available by
dragging the selector knob.
Solution -Use the arrow buttons next to the slider or click in the slider to the left or
right of the knob to see all the available increments.

a. Problem - Sample was recorded with a different type card.
Solution -If the sample was recorded with the AD1012 the same sampling rates will
not be available for the AD516, and vice versa. Use the resample option in the
Editor to change sampling rates or re-record the sample.

V. Card Communication Errors (e.g. "Comm Error #2", "GetW", "SendW" or
"DSP Init. Failed")
a. Problem - This very rare error usually means a hardware problem-cither with your Amiga or
the card.
Solution - Try resetting your Amiga, or turning it off and then back on. If this
doesn't help, try re-seating the card in another expansion slot. If this still doesn't
solve the problem, call SunRize technical support for more information.

VL. Cue List won't Trigger

a. Problem - Most often, the Cue List is just turned OFF.
Solution - For the Cue List to listen for time code and preload samples, it must be
turned on. Simply click the ON/OFF button at the bottom of the window to turn
Cue List ON.

b. Problem - Entries are not in the Open List, or they contain a typo.
Solution - When a sample is entered in the Cue List it will automatically calculate
and display the end time. If the end time is blank, (i.e., : : : ) the Cue List can
not find the file in Open List. Make sure the sample is listed in Open List, and the
two samples are spelled exactly the same.

¢. Problem - The SMPTE source may not be set correctly.
Solution - If you are using an external SMPTE source, like a VTR make sure the
internal SMPTE gen is closed. Also check the SMPTE source in Preferences. It
should be set to AD516#1 or AD1012#1. If you are triggering from the internal '
SMPTE gen, make sure it is loaded and it running.
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d. Problem- Too many errors in the incoming SMPTE time code. (Studio 16's internal
generator will not cause this problem.)
Solution - It may be a bad cable. You can also open SMPTE monitor and watch for
flashing squares in the upper left corner, they signify the time code errors. Error
detection can be turned off from the Cue List's Prefs Option. See the Reference
Section on Cue List for details.

e. Problem- The sample has been moved to another directory since the creation of the Cue List.
Solution - Move the sample back to the directory where it was when the Cue List
was created. Or, change the directory for the sample in the Cue List by replacing
the sample in the Cue List with the newly relocated sample from the Open List.

VIIL. Flashing Screens, or skipping, missing or repeating sound
Playback stutter or skipping occurs when your Amiga can't access the hard disk's data fast enough,
or doesn't have enough CPU time to service the sounds that are currently being played or recorded.
When Studio 16 detects this problem, it will flash your screen. The following are common causes
and solutions for "skipping" audio. Although the causes are listed individually, "skipping" is often
caused by multiple problems compounding one another rather than just one cause.

a. Problem - Your DMA mask setting on your hard disk may be incorrect. If your hard disk is
abnormally slow or has an inability to playback 1 or 2 tracks, you may need to
change the DMA mask for your hard disk.

1. Solution - If you have an A3000 or an A2000 with CBM controller, use
'HDToolbox' in your "Tools' drawer. Once HDToolbox is running, select "Partition
Drive" then "Advanced Options". Then select your partition from the "bar", and
select "Change file system for partition". Make a note of the original MASK then
change the MASK to: Ox7FFFFFFE. To save the changes, select "OK", "OK",
"Save changes to drive". You will need to re-boot your Amiga for the changes to
take effect.

2. Solution - If you are using a GVP hard disk controller, use "FastPrep” in manual
mode, instead of HDToolbox. See your GVP manual for more information. The
correct DMA MASK for GVP controllers varies--call GVP. However, on newer
controllers the above mask should work.

b. Problem - Your Amiga doesn't have enough CPU time to complete all the tasks required by
Studio 16 to play the requested sounds.

1. Solution - Turn off CPU intensive Studio 16 modules, such as Meters, and SMPTE
Monitor. Substitute Tiny Mixer instead of Mixer.

2. Solution - Upgrade your Amiga to a faster processor. If you have an Amiga 2000,
install a 68030 accelerator card with fast RAM. For example, a stock A2000HD
with the AD1012 doesn't have enough CPU power to play 4 tracks at 44K sampling
rates. It can handle one or two tracks at 44K or four tracks at lower rates, such as
15K. (The AD516 will play 4 tracks without an accelerator.)

3. Solution - Using Transport, combine samples to be played back simultaneously into
one sample. See Transport Reference Section on mixing for more details.

4. Solution - Upgrade your hard disk controller to a more efficient controller. The
amount of bus resources required to transfer the same data to or from your hard disk
can vary considerably between controller manufacturers. By switching to a more
efficient hard disk controller, you leave more time for the CPU to work. Probably
the most efficient hard disk controller currently available is Zeus 040 by Progressive
Peripherals. Since the controller is built onto the 040 board, it writes data at a high
speed and 32 bits at a time. This results in a significant performance increase.

S. Solution - Upgrade from an AD1012 to an AD516. SunRize's 16 bit card includes
extra circuitry that makes it more efficient at transferring data than the AD1012.
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¢. Problem - The hard disk is too slow for the number of samples playing. ‘

1. Solution - Reduce the number of simultaneously playing samples. If you can reduce
the number of tracks playing simultaneously, you will reduce the data transfer rate
and fix the problem.

2. Solution - Lower the Sampling Rate. If you lower your sampling rate, you can will
reduce the amount of data that must be transferred and improve over all system
performance.

3. Solution - Increase the Channel Buffer size in Preferences. By increasing the
playback buffer sizes, you will eliminate skipping in many cases. However, the
improvement will be less as you keep increasing the buffer sizes. That is,
increasing the Channel Buffers from 256K to 512K will have much more of an
improvement that increasing the buffers from 512K to 1024K. Keep in mind that
one channel buffer is allocated for each playing sample, and each sample preloaded
in Cue List. Make sure that you have enough system RAM to cover your requested
buffers. For example, if you play four simultaneous tracks with the channel buffer
set to 4096K, you will need 16,384K (or 16 MB) of free RAM just for buffers. For
more about RAM requirements, see the Preferences Reference Section.

4. Solution - Buy a faster hard disk.

d. Problem - The hard disk is fragmented.
1. Solution - Fragmented hard disks are discussed in Chapter 4. The solution is to buy
a program that will de-fragment your hard disk. Talk to your Amiga dealer for a
recommendation.

e. Problem - The 'Use Extended Memory' option in the Preference Menu is set incorrectly.

1. Solution - Select this button if your hard disk controller and '030/'040 card are on
the same PCB. (e.g. You have a stock A3000, or you have a GVP 030 card with
built in hard disk controller.) Do NOT select this button if you have an '030 or
'040, but your hard disk is on a stand alone Autoconfig card. (e.g. You have a GVP
series II DMA hard disk controller and a PP&S 040 card with 32 bit RAM.) See
the Preference Reference Section for details.

f. Problem - There is too large of a non-destructive edit in a sample.
1. Solution - Select Make Permanent from the Editor Menu.. When Studio 16 is
playing a sample and encounters a non-destructive edit, it must seek over the edit.
For large edits, this can take a long time and causes skipping.

VIIL. Full Hard Disk
a. Problem - Running out of hard disk space is a problem for everyone eventually, some sooner
than others.

1. Solution - Delete unnecessary data.

2. Solution - Make non-destructive edits permanent on samples that you have
performed non-destructive cuts. Note that Make Permanent temporarily requires
disk space equal to the file being made permanent. And, do NOT make samples
with non-destructive paste-inserts permanent, unless you're prepared to tie up more
disk space.

3. Solution - Buy another or a larger hard disk.

4. Solution - Reduce your sampling rate or resample your audio with a new rate in the

Editor.
5. Solution - Record or Convert samples that don't require a high SNR, like
explosions, to an 8 bit file ( [FF-8SVX). .
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6. Solution - Archive your samples on a tape backup or an alternate backup device and
then delete them from the hard disk.

IX. Gain won't adjust
a. Problem - Gain chip is malfunctioning.
Solution - The Digital Pot in the input gain circuit may be bad. Suspect this if you
can barely hear the input source or changing the gain level has no effect on the
input volume. Call SunRize technical support if you suspect this problem.

X. Graph does not match sound
a. Problem - Graph file has been corrupted.
Solution - Delete the sample's .graph file from the audio directory that contains
the problem sample. You can delete files with WorkBench or Shell.

XI. Hard Disk Read/Write errors
Hard drives aren't fool proof, and it is inevitable that you will at some point encounter a disk error.
This can manifest itself as a "Read" or "Write" error. Or, occasionally as a "Can't Validate Drive"
error. Sometimes clicking "retry” or "cancel" on the DOS requester presenting the error will
cause the error to disappear. However, if this happens you should start to worry because the error
will probably reappear later, and can mean a failing hard drive.

Of course your best advice is to backup your hard drives. They can be backed up to a SCSI tape
drive or a SCSI optical drive. However, due to the time and expense involved, many people don't
bother. Just be warned that a hard disk "crash" is not just a possibility, it is very likely that it will
happen to you eventually.

a. Problem - The hard disk gets intermittent read/write errors. - Some versions of the 1.3

FastFileSystem have bugs that cause Hard Disk Read/Write errors or crash when
used with Studio 16. These problems appear to be more pronounced when using a
SyQuest drive with a GVP series II controller.

1. Solution - Upgrade your GVP ROM's to the latest version.

2. Solution - Upgrade to WorkBench 2.0. It is much less buggy than 1.3

3. Solution - If you must use 1.3, upgrade the FastFileSystem to a more recent
version. We have included a recent version designed to work with 1.3 in the L'
directory on the Studio 16 Master Disk #2. Copy it onto your hard disk with the
SHELL.

Copy Studiolé_2:L/FastFileSystem L:

In order for the FastFileSystem to take effect, it must be copied to the Rigid Disk
Block (RDB). This is done with the same software you use to partition your hard
drive. NOTE: You must run your hard drive partitioning software (e.g.
HDToolBox) after installing WorkBench 2.0 or a new FastFileSystem in order for
the new file system to take effect. Contact your dealer or your hard drive controller
manufacturer for more information.

b. Problem - The hard disk has crashed. ,
1. Solution- Take your Amiga to your Amiga dealer. Their service department
should be experienced in attempting to restore data from corrupt hard drives.
2. Solution - Use a hard disk utility program to try and fix the errors on the hard disk.
This may or may not work, but if you have any amount of time invested in the data
on the bad partition, it's worth a try.
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3. Solution - Use a program like "DiskSalv" to recover the files from the corrupt
partition. "DiskSalv" is a public domain program that will copy files off a partition ‘
with errors onto a good partition. Once the operation is completed, you can re-
format the bad partition and copy the files back over. However, DiskSalv requires a
good partition or drive with enough free space to hold the copied files.

4. Solution - Re-format the partition that the error occurred on. This unfortunately
erases all data on the partition being formatted. You can do this with the
WorkBench "Initialize" option. Hopefully, you have a backup. If you do, restore
the backup after formatting the partition.

5. Solution - If you don't have a backup, you can attempt to copy the data from the bad
partition to another partition using WorkBench, DiskMaster/Opus, or the SHELL
copy command BEFORE re-formatting the bad partition. This will probably
recover some of the files, if not all. However, it does require a good partition or
drive with enough free space to hold the copied files.

XII. Some Modules Don't Open When Selected

a. Problem - This is usually caused by a missing system library in the libs: directory. If a Studio
16 library is missing, you will get a warning (e.g. "Can't Open Studio.library").
However, if certain operating system libraries are missing (¢.g. a math library)
programs will simply not run.
Solution - Copy the libs directory from your master WorkBench floppy into your
libs: directory on your hard disk. Insert you WorkBench Master disk into DF0: and
from shell, type:

copy DFO:1libs libs:

XIII. Samples loosing sync in Cue List or Transport
a. Problem - Samples have different sampling rates.

Solution - Multiple samples that playback simultaneously must have the same
sampling rate. You can alter the sampling rate of a sample in the Editor. From the
Effects Menu select the Resample option. Note that if the sampling rates are
drastically different, you'll hear one sample play at the wrong spced. However, if
the sampling rates are only slightly different, the samples will sound right, but
you'll loose sync as the samples play.
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Chapter 8

Third Party Sources

This chapter contains a list of third party products that you may find useful when using Studio 16. We
have only tested a few of these products. We are not recommending any of these suppliers, they are

provided for your convenience only.

SMPTE VITC to LTC Converters Horita
P.O. Box 3993
Mission Viejo, CA 92690 USA
(714) 489-0240

SMPTE LTC Generators MidiMan

MIDI to LTC Converters 30 N. Raymond

Pasadena, CA 91103 USA
(818) 449-8838

Studio 16 Compatible MIDI Sequencers

Bars&Pipes Professional

The Blue Ribbon SoundWorks, Ltd.
1605 Chantilly Dr., Suite 200
Atlanta, GA 30324 USA

(404) 315-0212

Video Effects Generator, Switcher, Paint
Box, and 3D Modeler

Video Toaster
NewTek Inc.
215E. 8th St
Topeka, KS 66603
(800) 765-3406
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Production Music

Killer Tracks

6534 Sunset Blvd.
Hollywood, CA 90028
(213) 957-4455

(800) 877-0078

Philadelphia Music Works
P.O. Box 947

Bryn Mawr, PA 19010
(215) 825-5656

(800) 368-0033

Valentino

151 W. 46th St.

New York, NY 10036
(212) 869-5210

(800) 223-6278

Sound Effects Libraries on CD

Sound Ideas

105 West Beaver Creek Rd., Suite #4
Richmond Hill, Ontario L4B 1C6 CANADA
(416) 886-5000

Valentino

151 W. 46th St.

New York, NY 10036
(212) 869-5210

(800) 223-6278

Removable Media Drive

SyQuest Technology
47071 Bayside Parkway
Fremont, CA 94538
800-245-2278

Magneto Optical Drives

Ricoh

3001 Orchard Parkway
San Jose, 95134
800-955-3453

Panasonic Comm. and Systems
2 Panasonic Way

Secaucus, NJ 07094
800-742-8086

VHS Deck modification that allows
simultaneous access to Hi-Fi and Linear
audio tracks. Decks include AG-1960.

Carlson-Strand Company
P.O. Box 3761

San Clemente, CA 92674
(714) 492-8978
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Module Reference

The Module References detail each Studio 16 module. Included is the name, class, and description of
every module and command and a detailed explanation of all gadgets and menus. Some modules also
include step by step instructions for common procedures.

Name: The name of a module as it appears in the Application or Project Menu.

Keyboard Shortcut: A keyboard equivalent is available for launching application modules by holding
down the control (Ctrl) key and typing the indicated letter.

Class:
Application Studio 16 program that performs a specific function for the user, e.g. Recorder.

Device Driver  Studio 16 module that communicates between the software and the
digitizing/playback hardware, €.g. AD516Handler

Utility Studio 16 program that provides services to Application modules, e.g. DiskIO.

Shell Command Studio 16 program that can be executed from the Shell to perform a specific
function, e.g. StudioPlay.

Description: Describes the function of the Module or Command.

Layout: Describes the appearance of the Module, generally including a screen shot.
Format: Lists the required format to execute a Shell command.

Procedures: Step by step instructions for the most common applications of a module.

Gadget Reference:  Detailed reference to each button and gadget for a module.

Menu Reference: Detailed reference for the menu options of a module.
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ADS516Handler

Name: ADS516 Handler
Class: Device Driver

Description: The ADS516Handler is responsible for handling data transfer to and from the AD516
card. There should be one AD516Handler resident for each card you have installed in
your Amiga. In general, you don't need to access the AD516Handler. However, if you
have installed multiple AD516 cards, you may need to use ModList to load another
ADS516Handler.

Procedures:

Check Hardware Revision Numbers & Statistics
1. Select Instance from the Applications Menu (* I).

2. Select Show Utilities from the Instance Menu. The Instance List will update showing
all the drivers and utility modules.

3. Double click the AD516Handler entry in the Instance List. An AD516Handler display
window will open with various version numbers and the amount of static RAM installed
in your AD516 card.

= AD516 Handlenr =

ADD16 Revision 1.68

Menop 128K Hords
DSP PKL .8
AUTO PAL o

a
Fil ten Type:Dlgltal 64 x
Erromn Rewv :1.68

SoftHl Type :29

Sof td Rew :8.14

Figure 1 - Typical AD516 Handler
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AD1012Handler

Name: AD1012 Handler
Class: Device Driver

Description: The AD1012Handler is responsible for handling data transfer to and from the AD1012
card. There should be one AD1012Handler resident for each card you have installed in
your Amiga. Installing more than one AD1012 is not recommended.

Procedures:

Check Hardware Revision Numbers & Statistics
1. Select Instance from the Applications Menu (* I).

2. Select Show Utilities from the Instance Menu. The Instance List will update showing
all the drivers and utility modules.

3. Double click the AD1012Handler entry in the Instance List. An AD1012Handler
display window will open with various version numbers and the amount of static RAM
installed in your AD1012 card.

!I AD1812 Handler =

AD1812 Revision 5.880
Menor 128K Hords
DSE Px\L ie

AUTO PAL .8

Filter Type:Butterworth V5.8
Epron Rew 19.81

SoftH Type :4

Sof tH Rew :1.081

Figure 1 - Typical AD1012 Handler
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Cue List

‘ Name: Cue List

Keyboard: ~C

Class: Application Module

Description: The Cue List module allows you trigger samples from SMPTE time code. SMPTE time
code is a time stamping format used in video production. Each video frame has a

specific time code associated with it. You can instruct Studio 16 to trigger a sample on
any video frame. This gives Studio 16 powerful audio for video editing capabilities.

Tutorial.List
Stant Tine End Tine Vol Sanple

BY.au .15

80:80:108:88 ([  _+8 |[DoorKnock f |

Figure 1. Cue List

. Layout: The Cue List window is comprised of three main elements. The List itself takes up the
majority of the window space. It displays each SMPTE event that Studio 16 will trigger.
Just below the Cue List is the Edit Line. The Edit Line is used to alter existing entries
in the Cue List. At the bottom of the window is an ON/OFF button. Figure 1.

Procedures:

Entering Samples

The are two methods for entering samples into a Cue List. The simplest is to click and
drag a sample name from the Open List or from the Editor Regions List into the Cue
List. This will automatically cause the SMPTE time code to update and you can be sure
the sample is available for playback.

The second method is to select Add from the Entry Menu. You can then type in a
sample's name from the file requester and hit return to add it. Note that the name must
be in the Open List and spelled exactly the same. With both methods, you can enter a
volume setting and a remark.

NOTE: If a sample has a SMPTE start time associated with it, you must drag that
sample in from Open List. Cue List will not be able to update the SMPTE Start
time if you type in the sample name in the Edit Line, (method 2).

Edit an Entry

‘ Highlight an existing entry by selecting an entry in the Cue List. The entry highlighted
will appear in the Edit Line at the bottom for editing. Type in any changes to the Start
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new Sample name. Make sure the new sample name matches a sample in the Open

Time, Volume or Remark, you can also change the sample all together by entering a .
List. Always hit return after making a change in the edit line to update the Cue List.

To replace one sample with another, highlight the sample to be replaced so it shows in
the edit line. Then, drag a new sample from the Open List or Editor Regions List and
drop it in the Edit Line. This will replace the original entry.

Delete an Entry

Select the appropriate entry in the list and select Delete from the Entry Menu, or type
A-D. This doesn't delete the file, it only removes the entry from the Cue List file.

Creating a Cue List with a Text Editor

You can also create and edit Cue List files using your favorite text editor. Simply load a
Cue List file (produced by the Save button in the Cue List module) into any word
processor or text editor and type in the changes. The correct format is as follows:

TQL.
Start Time ,Volume ,Sample Name ,Remark.!

Example:

TQL

00:02:01:00 ,+1 ,FootSteps ,Mike Leaves.!

00:02:30:00 ,0 ,pan 200, DoorSlam.!

00:03:04:00 ,-3 ,pan 150, CarStartAndGo ,Porshe 911.1

The first line of the Cue List must be "TQL' immediately followed by a hard return ()
for Studio 16 to recognize the file. The first character of text must immediately follow
the comma or start in the first column. Any number of spaces may follow the text and a
remark is optional. Pan will appear in the Remark field, (see Pan reference later in this
section). The end of each line should be followed by a hard return.

Adjusting Start and End Times

You can change the time code, by deleting the current time and typing in a new one.
Always hit return to update the Cue List.

A Shortcut for Changing the Start Time - delete the time in the start field and type +3.
This will add 3 frames to the original setting. To make the sample trigger 15 min., 8
sec., and 12 frames earlier. Delete the current setting and type -150812 in the start time
field, and hit return. You can omit the leading zeroes and colons " : ".

The end time is automatically calculated from the length of the sample and start time.
The end time of a cue event may be altered by changing the start time for the entry or
the length of the entry's sample in the Editor. If a blank End Time is displayed

( : : : ), Cue List has not found the sample in Open List. Check Open List to make
sure the sample is loaded, and it is spelled correctly in the Cue List.

Note: The recommended minimum Start Time is 1 second. This allows Studio 16 time
to preload the sample before it has to play it. ‘
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Cue List

To trigger part of a sample instead of the entire sample, use the Editor to create a region
‘ and drag the region's name from the Editor Regions List into the Cue List.

Loading and Saving Cue Lists

The Cue List Menu options, Load ,Save, and Save As are used to store and retrieve Cue
List files. To load an existing Cue List select the Load button. A File Requester will
open allowing you to choose a Cue List file to load. To store a Cue List for later use,
select the Save As button. A File Requester will open asking you for the name of the
Cue List file. Type in the name of the file you wish to save and then select the OK
button.

Note: A Cue List file does not contain samples, it is a text file that contains
descriptions of cue events to be triggered.

Triggering the Cue List

The Cue List must be ON for samples to trigger. Also, the SMPTE generator (figure 2)
must be running, or an external source has to be plugged into the AD516 or AD1012
and running.

To play an individual sample, select Play from the Entry Menu.

Triggering from the middle of a sample is useful when you are working with long
samples and it is more convenient for you to start time code in the middle of a long
sample. Generally samples are triggered on the specified time code. But if time code

‘ starts or jumps to the middle of a sample, Studio 16 will attempt to trigger the
remaining portion of the sample. It may take Studio 16 several seconds to find the
correct position to start playback, especially if the computer is busy, or if the sample is
long and you are triggering near the end.

Figure 2. SMPTE Generator

Selecting SMPTE Frame Rate and Source

Use Preferences from the Project Menu to choose your SMPTE frame rate and default
source. This generally only needs to be set once.

Studio 16 supports SMPTE frame rates of 24, 25, and 30 frames per second. Make your
selection and select SaveSetup from the Project Menu. (More details are available in the
Preference Reference Section.)

In most cases, the default SMPTE source will be correct. The default should be either

. the AD516 or the AD1012. So whenever time code in coming into the card, SMPTE
monitor will display the frame count if your external source, provided it's turned on.

51



Module Reference

Gadgets:

List

Start Time

End Time

Vol

Sample

Remark

Pan

When you work with the Studio 16's SMPTE Generator, Preferences will override the
default setting with SMPTE gen.

The current list of samples set to be triggered. Displayed is the start and end time,
volume, sample name, and an optional remark for each entry. Entries are generally
dragged in from the Open List or the Region List in the Editor.

The time the sample will begin playing. Units are in SMPTE format - HH:MM:SS:FF
(hours:minutes:seconds:frames). Suggested minimum Start Time for each sample is
01:00. This allows Studio 16 time to preload a sample before having to play it. The
start time can be altered by changing it in the edit field or deleting the time and typing
in an incremental change like +3 to add 3 frames the existing time.

The calculated time the sample will stop playing. It is not adjustable. Use the Editor to
create a smaller region for samples that are too long.

The selected Volume (in decibels) at which the sample will play. Entries can range
between +06dBs to -99dBs.

+06 dBs = 200% Volume

0 dBs = 100% Volume
-06 dBs = 50% Volume
-12dBs = 25% Volume

The name of the sample. It must match an Open List entry exactly.

Optional note attached to a Cue entry. Will also accept commands for setting the pan.

ADS516 ONLY You can set the pan for a sample by entering a special command in the
Remark field. Pan allows you to vary the level of audio to playing on each channel. The
ADS16 has two channels, and you can set a sample to play on either the left, right, or
both output jacks. When pan is set to 100, the sample will play equally on both the left
and right output. If the pan is set to 0, the sound will only play on the left output. If
pan is set to 200, the sample will play only on the right. You can also vary the levels on
each output. For instance if the pan is set to 103, the sound will be 3dBs louder on the
right than on the left.

The following are examples of the format for setting a pan in the Remark field. Make
sure the 'p' in pan is the first entry in the remark field.

pan 0 full left
pan 100 center (left and right equal)
pan 155 55dBs higher on the right

pan 200, door closes full right
The usual remark like "door closes" can be entered after the pan setting. In the above

sample the door closing sample would only be heard on the right channel, which is
appropriate if the door is to the right of the viewer.
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Cue List

Edit Line

Menu: Cue List
New

Load

Merge

Save

Save As

Offset

Prefs

Samples recorded in stereo will automatically default to the correct pan setting. You can
override this by entering a new setting in the Remark field or by resetting the default
pan value in the editor.

The update boxes at the bottom of the window show the name, start time, vol and
remark for the highlighted sample. An entry in the Cue List can be edited by
highlighting it and typing into the Edit Line fields. Always hit the Enter key to update
the Cue List.

Select this option to clear the current entries.

Allows you to load a Cue List File. It brings up an Open File Requester at the default
directory Studiol16:CueLists. A Cue List file is a text file that contains sample names,
vol., etc. In addition to loading a Cue List file, the actual samples must be in the Open
List before they can be triggered.

The default directory can be changed, by selecting a new directory in the requester and
then selecting Save Setup from the Project Menu.

Allows you to merge two Cue List files. The new file will sort itself by start time.
Save the changes made to the Cue List with the current file name.

Select this option to save the current Cue List with a new name. It brings up a Save File
Requester at the default directory of Studiol6:CueLists. The file saved consists only of
sample names, start times, volume settings and optional comments.

Allows you to enter a global offset for all entries in a Cue List. The offset can be typed
is as a complete time code, 00:01:23:14, or without the leading zeroes and colons
(12314), or as an incremental change +1202.

Reaction (frames)
Sets the reaction time for TC Add and TC Update. If the start times you add with TC
Add (4-T), are continually 2 frames late, change the reaction setting to -2 frames.

SMPTE Errors

When SMPTE Monitor is running, it is set to detect three types of errors. When these
errors are detected, you will see flashing squares in the upper left corner of the SMPTE
Monitor. Every time a square flashes, it means that a type of SMPTE "error” was
detected. The detection of these errors may cause a sound to stop playing. Turn off the
error detection by deactivating the error.

Each of the three squares in the SMPTE monitor represent a different error. The three
squares from Left to Right are:

SMPTE Time Out [white] - No time code was detected for about 1/2 a second.
Pausing your video deck will cause this.

SMPTE Time Code Error [black] - This error is generated if an illegal time
code is read by the SMPTE reader. For example, a time code with 69 seconds
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Menu: Entry

Add

Duplicate
Delete

TC Add

TC Update

Play

Stop

would generate this error. This error typically results from distortion, usually a
bad cable, a bad connection, or tape drop out.

SMPTE Time Code Jump [yellow] - This error means that a discontinuity
occurred in the time code. For example 00:01:00:01, 00:01:00:02,
00:03:00:12, 00:03:00:13 would cause this error. Jumps typically occur when
you fast forward or rewind the time code source.

Figure 3. Cue List Prefs

Preload

This is the number of entries that are preloaded into RAM before playback. The default
for the AD1012 is 5. It should be adequate unless you are triggering a lot of short
samples (samples under 2 seconds in length). If you are using the AD516 increase the
preload number to 9. Note that for every sample preloaded you must have an available
channel buffer. Example, if the channel buffer in Preferences is set to 256K, and you
want to preload 8 samples, you must have at least 2 Megs free.

Enters a blank entry at 00:00:00:00. The biank entry can then be edited from the edit
line. Or you can replace the blank entry by highlighting it and then dropping a new
entry from the Open List or the Editor Regions List in the Edit Line. This will replace
the black entry in the list.

This button duplicates the highlighted entry in the Cue List.

Click this button to delete the highlighted Cue List entry.

Adds an blank entry at the current time code. It allows you to select hot spots in a video
by hitting (4-T) every time you see a frame you want to trigger audio on. You can later
drop samples in on these time codes. Set a reaction time for TC Add with the Prefs

Option in the Cue List Menu.

Changes the start time of the highlighted entry to the current time code when selected.
You can set a reaction time in Cue List Prefs.
This button plays a single highlighted Cue Entry. To trigger the Cue List in sequence,

activate your SMPTE source or the internal SMPTE Generator.

Stops all samples playing back. To stop the playback of a Cue List that has been
triggered, turn the Cue List OFF. Or, stop the SMPTE time code generation.
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’ Name: DiskIO
Class: Utility Module

Description: Responsible for handling data transfer to and from your hard disk, DiskIO is not a
module that requires user access.
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Editor

Name:
Keyboard:

Class:

Description:

Layout:

Editor
AE or A-E*
Application Module

The Editor allows you to manipulate the data of sound files. It is accessed from
Applications Menu or from the Open List. From the Applications Menu, load an
empty editor by selecting Editor. To open an editor for a specific sample, highlight a
sample in Open List and select Edit Sample. Note that multiple select works to edit
samples simultaneously.

Editing is accomplished in Studio 16 much as it would be with a traditional 8 bit sample
editor like Perfect Sound or Audition 4. An editor displays a graph of the sound being
edited and allows you cut, copy, and paste sounds. You can move parts of a sound
around, delete unwanted sections, fade in or out sections of sound, or even reverse
sound. You can also use the "frechand" mode to draw with the mouse to remove pops.
In addition, the editor also allows you to change a sample's default playback rate,
volume, and filter setting and contains more advanced features like echo, FFT, and
resample.

Spirit:Samples/GTair_Lick

Figure 1. Editor Window

Status Display

Along the top of the Editor is the status display. It includes numerical positions of the
marked range and the current graph display. The numbers on the far left and right are
the first and last positions for the entire display. The numbers toward the center of the
window are the fist and last positions of the marked range. The length of the range is
displayed in parentheses.

The status display is generally shown in SMPTE time code. It can be displayed in
numbers of samples by activating Units in Samples in the Editor's Option Menu.

) Opens an empty Editor.
A-E Opens an Editor with a sample loaded provided the sample is highlighted in the Open List and the Open List window is active.
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Graph

Buttons

The status display is generally shown in SMPTE time code. It can be displayed in
numbers of samples by activating Units in Samples in the Editor's Option Menu.

You also have the option of entering an offset for the status display. The offset is added
from the Editor's Option Menu - Set Display Offset. An offset is often used in
conjunction with the Cue List. For example, when editing a sound that is also entered
in the Cue List, you can set the offset equal to the Cue List start time code. So when you
drag ranges, the SMPTE display of the ranges in the editor window will match the
sound's position on tape.

Most of the Editor window is occupied by a sound's graph. The vertical axis of the
graph represents the amplitude of sound, and the horizontal axis represents time.

Because Studio 16 samples are hard disk based (they are not in RAM), the editor has a
unique difficulty. How can a graphic representation of the digitized sound be displayed
fast enough to be usable? Studio 16 solves this problem by building a graph in RAM
from hard disk, and using this "graph buffer" to display the "on screen" graph.

When you first edit a sound, a window will appear and a graph will begin to form from
the left to the right. Your hard disk light will also be quite active. Studio 16 is building
its "graph buffer", a process that only has to be done once - when you first load the
sample in the editor. For long samples, this can take a while. For example, a 3-4
minute sound (~14 MB) will take about 40 seconds to build the graph. This process can
be sped up slightly by increasing the "Copy Buffer" in Preferences. Once the graph is
built, the editor window will be redrawn with the graph displayed. For quicker graph
updates, select the Fast Graph option in the Editor's Options Menu.

Editing is accomplished by dragging your mouse over the graph to mark a range, then
selecting one of the editor menu options.

The navigation buttons are located along the bottom of the graph. See the Gadget
Reference for a detailed explanation of each button.

Common Procedures:

Load a Sample and an Editor

1. Select Open List from the Applications Menu. (*O)
2. Select a sample to edit, and then select Edit Sample from the Open List Menu.
“-E)

Removing Leading Dead Space

1. Examine the beginning of the graph to note where the dead space, or silence
appears.

2. Using the graph as a guide, use your mouse to drag a range highlighting the silence.
This will be easiest if you click on the right side of the intended range and drag to
the left. By dragging past the left edge of the graph, you will be sure your range
includes the first sample.
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Type 4-L to play the marked range to listen to the area you have just highlighted (or
select Play Range from the Editor Menu). You should not hear anything, except
perhaps background noise.

On the basis of listening to the range, you may want to fine tune your marked range.
You can use the mouse to grab the end of the marked range and adjust it. To get a
closer view of your sample, click the Show Range button, and then click the Zoom
Out button to zoom out a little.

Once the range is finalized, select Non-Destructive Cut from the Edit Menu. You
have now performed a "non destructive cut." The data you have deleted is still on
your hard disk, but will not be played when you access the sample. You can restore
it by selecting Undo Last.

If you want to free the hard disk space currently being occupied by the silence, you
need to make the non-destructive edit permanent. Select Make Permanent from the
Edit Menu. This operation can take a while, depending on the length of your
sample. Once it is complete, the graph will be regenerated.

Fading a Sound In

L.

2.

Examine the beginning of the graph to note where the fade should occur.

Using the graph as a guide, use your mouse to drag a range highlighting the section
to fade. This will be easiest if you start on the right side of the intended range and
drag to the left. By dragging past the left edge of the graph, you will be sure to start
your fade on first sample.

Type A-L to listen to the area you've just highlighted.
On the basis of playing the range, you may want to fine tune your marked range.
You can use the mouse to grab the end of the marked range and adjust it. Zoom In

for a closer look of the waveform by clicking the Zm In button.

Once the range is finalized, select Scale from the Effects Menu.

NOTE: Fades are permanent. Once done, they can not be undone. You may want
to make a copy of the sound before doing a fade as a reserve. To make a
copy of a sample, click the Range All button and then use the steps in the
next section for copying a range to a new sample.

A Select Scale Requester will appear. To fade in, change Start to 0%, and End to
100%. Figure 4. To fade out you would set Start to 100% and End to 0%.

Scale/Fade ‘Dr_Kick’

Figure 4. Scale Selector
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7. Click OK.

8. The fade will now be performed. It may take a while, depending on the length of

the marked range.

Creating a new sample out of a marked range

1.

Highlight a range on the main graph. A new sample will be created out of this
range. To duplicate an entire sample, click the Range All button.

Select Destructive Copy from the Edit Menu. A destructive copy will cause a new
file to be created from the marked range called CopyBuffer.

Bring the Open List module to the front by typing ~O, or by selecting it from the
Applications Menu.

Select the sample CopyBuffer in Open List.

Select Rename from the Open List Menu and type in a new name for the sample
and hit the Enter key.

Pasting a Range from One Sample into Another

L.

2.

Before you begin this tutorial, close all modules except Open List.

Pick two samples in the Open List that have the same sampling rate. They will be
referred to as SourceSample and DestinationSample.

Highlight one of the samples in the Open List and type A-E, or select the Edit
Option from the Open List Menu.

Bring Open List to the front (*O). Highlight the second sample and select Edit
again to open a second Editor.

You now have 2 editors open. Resize and move the Editor windows so that you can
view both of them on your screen at once. Figure 5.

Mark a range on the graph of the SourceSample. This will be pasted into
DestinationSample.

From the SourceSample editor, select Destructive Copy. At this point, a new
sample will be created called CopyBuffer.

Mark an insertion point for the range in the DestinationSample.

In the DestinationSample Editor, select Destructive Paste - Insert at Start.
CopyBuffer will be inserted now. The process can take a while if the files are large.
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Editor

Project

Applications

Copy

Paste

Keep

Delete

Undo Last

Undo All

Make Permanent
Postpuc tiva
Cut

RAM:DestinationSanple

Buttons:
Play Range
Stop
Show All
Range All

Show Range

Zm In

Figure 5. Moving a Range from SourceSample to DestinationSample.

This will play the marked range in the editor window.

Any playing sound is stopped.

Adjusts the zoom ratio so that the entire sample is displayed on the graph.
Will create a range over the entire sample. Will also Show All in the process.

This expands the marked range to fill the graph - changing the zoom ratio and the
scroll as needed.

To "Zoom in" on your sound's graph to see more detail, click this button. Successive
clicks will zoom you in closer until you are zoomed all the way in. When zoomed all
the way in, you will be viewing the sample on a scale where each horizontal screen
pixel represents one sample.

Once you've zoomed in on a sample, you can use the scroll bar along the bottom of the
graph to move around in the sample. Usually the graph is updated from the "graph
buffer”, so scrolling is a very quick process. However, if you zoom all the way in,
the editor may access the hard disk. When this happens, the updates will become
slower, and you will see the hard disk light flash. To speed things up, zoom out a
little.
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You can also zoom in on the sound by marking a range (use your mouse to drag a ‘
range on the graph) and then clicking the Show Range button. This will expand the
marked range to fill the graph.

Zm Out Reverses the zoom ratio, so you can see more of a sample. Click Show All to zoom all
the way out of a sample quickly.

Menu: Editor

New Clears all samples from the Editor Window. The samples are not deleted, they are
just removed from the Editor.

Open Opens a file requester allowing the addition of a sample to the display. Up to 8
samples can be in the editor at once allowing synchronous edits.

Play All Plays the entire sample in the editor. You can also play sounds from Open List,
Transport and Cue List.

Play Range This will play the highlighted range on the graph.
Play Display Plays the portion of the sample that is currently displayed in the graph.
Play to Start Plays a small portion of a sample preceding the marked range.

Stop Playing All playing sound is stopped.

Menu: Edit

Non Destructive
A "non- destructive” edit will not alter you original sound. It just remembers which
changes have been indicated. Since non-destructive edits don't alter your hard disk data,
they can be "undone” at any time to restore your original data. Another benefit of "non-
destructive" edits is speed. Since hard disk access is not required, non-destructive edits
are much faster to execute than destructive edits.

Non-destructive edits only work on one sample at a time. That is, you can't do a non-
destructive copy, then paste the copied range into a different sample. The non-
destructive paste must be into the same sample where the non-destructive copy was
performed.

Cut This is the same as selecting a non destructive Copy and Delete. If you want to delete a
range while maintaining the sound after the cut in sync, use zero.

Copy This remembers the marked range for use in future pastes. No new sample is created.

Paste Non-Destructive Paste has a submenu that determines where to paste:
Insert at Start
Insert at End
Replace Range
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Selecting Insert at Start or End will insert the copied range at the beginning or end of
the marked range. Selecting Replace Range will replace the marked range with the last
copied/cut range.

The non-destructive Copy - Paste - Insert action allows you to duplicate a section of
sound repeatedly. You can insert multiple copies of a range into a sample without using
more hard disk space (unless you select Make Permanent or do a destructive edit).

NOTE: With Studio 16 version 2.0 there is a limit of 128 non-destructive edit clips.

]

Keep This edit is the inverse of delete. It deletes all of the wave except what is highlighted in
the marked range.

Delete This deletes a marked range (it can be reversed by Undo). To delete a range while
maintaining sync, use zero. (NOTE: Zero is destructive.)

Undo Last This will undo the last non-destructive edit. It does not have any effect on other types of
edits or effects. Clicking Undo a second time will reverse the Undo.

Undo All  This option will undo all non-destructive edits. It has no effect on destructive edits or
effects.

Make Permanent

Allows you to do non-destructive editing on a sample and then transform the results into
a permanent sample with a single "destructive edit". This option will update the current
sample's data taking non-destructive edits into account. Performing a destructive edit
will also make all non-destructive edits permanent.

There are two reasons to make non-destructive edits permanent:

1. You have performed non-destructive cuts on a sample so that if the edits were made
permanent only a fraction of the disk space would be required by the sample.

Example - You record a 20 MB sound file, then edit the sample in the non
destructive mode, doing cuts, copies and pastes. The resulting sound would fit in a
much smaller SMB space. However, since your edits were non-destructive, the
original 20MB file is still on your hard disk. If you're confident you won't need the
original unedited sample, by making the edits permanent you can create a new
sample that contains just the 5SMB of edited data, thus, freeing 15MB of hard disk
space.

2. You are experiencing long delays between selecting Play All or Play Range and the
sound actually playing. This happens when the computer must seek long distances
from the beginning of the sound's data file to find the point where playback begins.
AmigaDOS seeks can be quite slow. As a result, you may want to make the edits
permanent to eliminate the delay.

NOTE: Make Permanent will create a new file on your hard disk, then delete the old
file. As a result, it will not work unless there is enough free space on your hard
disk to temporarily hold both the original file and the new "compressed" file.
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NOTE: Make Permanent can make a file larger if you have performed many Paste -
Inserts.

DESTRUCTIVE

Cut

Copy

Copy As

Paste

Delete

Keep

An edit is "destructive" if it alters your sample's data on the hard disk. Destructive edits
are generally used to transfer clips from one sample to another. (Non-destructive edits
only work within a single sample.) For example, if you wanted to cut part of sample and
paste it into an another sample, you would have to use Destructive Copy and Paste.

Destructive edits are also used when you want to create a new sample from an existing
sample.

As well as the destructive Cut, Copy, and Paste, effects are also destructive. These
include Resample, Scale, Invert, and others.

A destructive cut will remove a marked range and place it in a sample called
CopyBuffer. CopyBuffer is a normal sample in all respects, except that by convention it
is used in Destructive Paste. CopyBuffer is created in the active directory.

Destructive copy will copy a marked range into a new sample called CopyBuffer.

It is often useful to create a new sample out of a marked range. Copy As will bring up a
file requester and prompt you for a name for the new sample.

NOTE: Copy As will create the new file with the default file format set in Preferences.
This allows you to easily create samples in different file formats from ranges of
original samples.

Destructive Paste, like its non destructive counterpart, has a sub menu that allows you to
select where to paste:

Insert at Start

Insert at End

Replace Range

Selecting Insert at Start or End will insert any sample named CopyBuffer at the

beginning or end of the marked range. Selecting Replace will replace the marked range
with the contents of CopyBuffer.

To transfer a clip of sound between samples, do a Destructive Copy in the source sample
followed by a Destructive Paste in the destination sample.

To append one sample to another, select Insert @ End. But make sure the destination
sample's range includes the last sample of the sound.

Delete will remove a range from the sample. A delete is similar to a cut, but it does not
create a CopyBuffer, and it is quicker to perform. It may be preferable to delete a
range, if you are working with long samples and you are certain you do not require the
marked range. There is no undo for delete.

Keep is the reverse of delete. It will remove all of the sample except for the marked
range. It is safer to do a non-destructive keep and then make the edit permanent.
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Menu: Effects

Echo

FFT

This option brings up an echo range requester that allows you to set the Delay, Feedback
and DLevel of an echo. These settings are similar to the Realtime Delay Parameters.
Try will preview the effect; however, it requires an accelerated Amiga.

" Echo Range in 'Dr_Snape’

Figure 6. Echo Selector.
Delay Adjusts the length of time between repeats.
Feedback Controls the number of echoes you hear. This is accomplished by

adding a percentage of the delayed signal back into the original.

D Level Controls the volume of the echoes, at 100%, the first echo and the
original signal are the same volume. At 0% you will not hear an
echo.

Fast Fourier Transform breaks down a waveform into its constituent sinusoidal parts.
The "Fourier Transform" is a mathematical transform that translates time domain
information (like sampled sound) into the frequency domain. The "FFT", or "Fast
Fourier Transform" is a computationally efficient method of computing the Fourier
Transform. Actually, Studio 16 implements the "DFT" or "Discrete Fourier Transform".
However, many people use FFT and DFT interchangeably.

= FFT of GTair Lick [18818,18529]

Figure 7. FFT Display
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Invert

Normalize

Reverse

Scale

Zero

Resample

present in the samples analyzed. An FFT algorithm always processes a power of 2
samples. In Studio 16's case, it always processes 512 samples. It then produces 256 real
"frequency samples". Each of these points is plotted by Studio 16 in a bar graph. Since
there always 256 points, or "bins", these bins contain a range of frequencies. The center
frequency in this range is displayed in the upper right hand corner as you move the
Cursor.

In any case, the FFT will produce a plot that shows you which frequency components are ‘

When selecting a range for an FFT keep in mind that only the first 512 samples will be
used in the calculation. To mark a range that is exactly 512 samples in length, activate
Units in Samples from the Option Menu in Editor. Then, watch the range's status
display (the center most numbers along the top of the graph) as you adjust you range to
512 samples.

This option inverts the ranged waveform along the y-axis. The sample will not sound
different.

A variation of scale that first measures the peak value of the sample, and then scales the
entire range by the percentage required to bring the peak to a maximum setting. The
maximum level for 16 bit samples is 32,767. Refer to Chapter 1 for more information
on maximum levels.

Normalize can also be used to find the maximum sample in a range since it is
determined before scaling and you can always cancel the normalization before it alters
your sample.

This option will reverse a sound's data so that it plays backwards.

This option allows you to scale (attenuate or amplify) a sample. It also allows you to
fade in or fade out a section of a sample by specifying a starting and ending percentage.
When they are equal, a straight scale is performed. When the percentages differ a fade
will be performed. By combining Editor Fades with the Cue List, cross fades can be
performed.

When using scale to increase the level of a range at an even rate, consider using
Normalize.

Studio 16 Scales are linear. To produce a logarithmic scale, scale the same range twice
at the same setting.

Mark a range and select zero to silence the existing audio. This will allow you to
remove sound from a track while maintaining sync throughout the entire track.

Allows you to adjust the sampling rate of a sample. The parameters will affect the
quality of the sample and the amount of RAM required. Also, resampling is a complex
operations, so it may take a while, especially if you are working with long samples.

Resample can also be used to "pitch shift". Resample a sound to a new rate, and then
playing it back at its original rate.

66



Editor

Gen Silence

Resolution

Resanple Range '’ Dr_Snare’

Resolution Filter Order
r i &
il I I

Current Rate

New Rate Tine (25MHzZ)
44247

RS o

Figure 8. Resample Selector.

Because resampling is very calculation intensive, Studio 16 pre-
computes a sinc table for speed. "Resolution” refers to the size of the
sinc table. The normal table is provided for machines with small
amounts of RAM. High Resolution requires more RAM, but may
give slightly better results because it uses a larger table.

Filter Order Resample is controlled by a digital filter. Digital filters allow you to

set an order of the filter or the degree of accuracy. The larger the
order of the filter, the more accurate the resample will be. However,
high filter orders take longer to process. The Filter Orders that are
available for resampling are 5, 11, 21, 101.

Current Rate  The default sampling/playback rate of a sample before resampling.

New Rate

Time

A field for entering the new sampling rate. (Open the Recorder to
see the available rates your AD516/AD1012 can playback)

The estimated time required to process the resample. Note the field
will update as you select different filter orders. This estimated time is
for an Amiga 3000 with a 25MHz processor. Stock Amiga 2000s
will take much longer. :

This option will create silence in the CopyBuffer. A requester will appear allowing you
to select the length of the silence and the sampling rate. Once the silence is in the
CopyBuffer, you can select destructive edit and paste the silence into your working

sample.

Sampling Rate  The default sampling rate is from your working sample. If you

Seconds

intend to copy the silence into another sample, you should use that
sample's rate.

The number of seconds to be generated. Fractions are okay (e.g.
1.25)
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Gen Silence

Samp Rate: 44188
Seconds: 1.6

Lok SR

Figure 9. Generate Silence Selector.

Gen Sine Wave This option will create a pure sine wave in the CopyBuffer. A requester will appear
allowing you to select the length of the sine wave and the sampling rate. Once the sine
wave is in the CopyBuffer, you can select destructive edit and paste the sine wave into
your working samples. This option is well suited to creating a 1,000Hz sine wave that is
often used in the beginning of an audio tape for reference purposes.

Gen Sine Have
Sanp Rate: 441868
Seconds: 1.8

Have Freq: 1a88.0

Figure 10. Generate Sine Wave Selector.

Sampling Rate The default sampling rate is from your working sample. If you
intend to copy the sine wave into another sample, you should use that
sample's rate. Note your Sampling Rate should be at least twice,
preferably four times, the frequency of the sine wave.

Seconds The duration of the sine wave. Note that the longer sine waves the
longer it will take to process.

Wave Frequency The frequency of the wave should be no more than 50% the sampling
rate and preferably no more than 25%.

Menu: Options
Set range  Using this option, you can enter a range numerically. Instead of dragging a range with
the mouse, you can use Set Range to set the range exactly in either number of frames or
number of samples (set by the Units in Samples menu option).
Set Start  This is an "on the fly" operation that allows you to set a range while a sample is playing.

Select Play All for a sample and then use the keyboard shortcuts for Set Start (4-M) and
then Set End (4-E).
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' Set End

Used in conjunction with set start allows you to set ranges when listening to a sample
play. 4-E.

Set Sample Parms

Use this to alter the sample's default volume, playback rate, as well as the filter rate for
ADI1012s, and the pan for AD516s.

The default volume is the level at which the sample plays. It will usually be +00dBs.
The Mixer will automatically adjust itself to this level when the sample is played.
However in Transport, if Manual Vol is selected, the current mixer setting will be used.
Use Auto Volume to use the rate set here.

Default Sanple Paraneters ‘Dr_Kick’

Figure 11. Sample Parameters Selector.

See the Reference Section on Recorder for explanation of sampling and filtering rates.
If you have trouble selecting a sampling rate that is available in the Recorder, use the
arrow buttons or click in the slider to the left or right of the knob. This will display all
available increments. Just dragging the knob may not show them all.

The pan adjustment allows you to vary the level of audio to playing on each channel.
The ADS516 has two output channels, and you can set a sample to play on either the left,
right, or both output jacks. When the pan slider is in the center, the sample will play
equally on both the left and right output. If the pan slider is all they way to the right,
the sound will only play on the right output. If the slider is all the way to the left, the
sample will play only on the left. You can also vary the levels on each output.

Stereo is accomplished by recording two tracks: one panned full left, and the other
panned full right. You use pans that are not full left or full right when playing back
mono tracks that you want to appear on both the left and right outputs.

Set Display Offset

Loop

Prompts you for a time to offset either the display or the marked range. Changing either
the offset will effect the other. If you know the exact frame you want the sample to
trigger on, set the display offset to this frame. On the other hand, if there is an
embedded sound effect in the middle of the sample (marked by a range), and it is crucial
that it play on a specific frame, set the range offset to that frame number. The display
offset will automatically calculate a new offset, to match the new range entry.

Activate Loop to have the sample or marked range play continuously.

Freehand Draw

When activated, you can use your mouse to alter a sound's data. Selecting frechand will
automatically zoom all the way in. To edit normally, deactivate the option or zoom out.
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OK Requesters
When activated OK Requesters will appear for all destructive edits and effects. It is .
recommended that users new to Studio 16 leave "OK Requesters" activated until they
become more familiar with Studio 16's operation. Advanced Users will probably want to
turn off this option. A few crucial requesters are not optional and will remain even
when OK Requesters is deactivated.

NOTE: OK requesters can generally be accepted or rejected with the standard keyboard
shortcuts Left A-V and Left 4-B for OK and cancel.

Units in Samples
The graph and status display is generally displayed in SMPTE time code. If you prefer
to work in number of samples, activate this option.

Show Regions
Regions are marked ranges that have been given a name. Regions are like samples in
that they can be dragged into the Cue List and Transport. Show Regions will bring up
an "Editor Regions List" that lists all the regions in a samples. You can drag from this
region List. The "Editor Regions List" has Menu Options of it own.

Project Applications REESTLES

— Edi tor Regions

Figure 12. Editor Regions List and Regions Menu.

Add Region Brings up a name requester for the marked range. This range will
then be converted to a region that can be dragged into the Cue List,
or Transport. Its name will appear in the Editor Regions List along
with any other regions existing for that sample.

Delete Region  Highlight a region's name in the region list and select this option to
forget the region. Note that no data will be lost, this is not a cut, or a
non-destructive delete.

Update Region Allows you to adjust the region's length. Click on a region's name in
the Editor Regions List, then click on the graph and move the start or
end markers of the region. Next, make the Editor Regions List active
by clicking on the title bar, then select Update Region to update the
region with the new length.

Grid Displays a vertical grid that indicates boundaries within a sample. The type of grid is
set with the submenu. For example, you can request that a vertical line be drawn on
frame or one second boundaries.
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Note that you may have to zoom in to see the grid lines. This is because the Editor will
not draw grid lines when there would be "too many" drawn. In other words, if the editor
thinks that you're going to have trouble seeing the waveform through all the grid lines,
they will not be drawn.

Set the grid to one of the following settings, or turn it off. Note that the grid is a display
only, it does not "snap".

OFF
1 Frame
1 Second
10 Seconds
1 Minute

Fast Graph When activated, the graph display update is quicker, but less representative of the actual
sample.
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Name: Instance
Keyboard: A
Class: Application Module

Description: The Instance List can be used to launch Studio 16 modules just like the Applications
Menu and Keyboard Equivalents. Instance is loaded from the Applications Menu. And
once loaded, all other application or utility modules can always be on display rather than
in the menu. Usually, due to limited screen space, it is preferable to use the
Applications Menu and keyboard shortcuts.

Menu: Instance

Edit Brings up a requester giving you the option of renaming a module or making a module
resident or non-resident. All Studio 16 modules reside on your disk in the Studio 16:
Application, Drivers, and Utilities directories. For each module, there is one program
file in this directory. As with all programs, a Studio 16 module must be in RAM to run.
However, when you are not using a module, the module's code can be removed from
RAM. The resident/non-resident option lets you decide if you want to keep a particular
module's code in RAM even when the module is not being used (Resident) or whether
you want to free RAM for use by other programs and remove a module when it is not is
use (Non-Resident).

The advantage of keeping a module resident is speed. A resident module's window will
open immediately when you double click its name in the Instance List since it doesn't
have to be loaded from disk. A non-resident module will take a second or so to load
when you double click its entry in the Instance List. For this delay you save a small
amount of memory. The amount of memory (RAM) saved is relatively small so it's
advisable to keep commonly used modules resident.

The Utility and Driver modules should always be resident. Application modules may be
made resident at your discretion.

Duplicate This option creates another Instance of a particular type of module. For example, select
the Meters entry and click the Duplicate button. You now have two entries in the
Instance List, Meters and Meters#2. This enables you to load two Meters modules
simultaneously, allowing you to show eight meters at once. However, many Amigas will
not have enough CPU time for this.

Remove This option removes an Instance from the list. For example, if you don't require that
second meter module (added in above example), you can select Meters#2 and then click
the Remove button. Once a module is completely removed from Instance, you will have
to load ModList to add it back.

Show Sets Instance to display Applications, Utilities, or both. Utility Modules are used in the
operation of Studio 16. They are not usually accessed by the user. However, you may be
interested in selecting the AD516 or AD1012Handler. It will display statistics about
your hardware.
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Figure 1. Instance List showing Application Modules
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MessageMonitor

Name:
Class:

Description:

Procedure:

MessageMonitor
Application Module (Dormant)

The Message Monitor is a handy debugging tool for Studio 16. This module is for
programmers - most users will not require opening it. It displays all the messages
passed between the different Studio 16 modules. It should be noted that message
monitor can run at low task priorities, while most other Studio 16 modules run at higher
priorities. This will cause a backlog of messages to be queued if the computer is fully
loaded. These messages get processed by the higher priority Studio 16 modules before
they are displayed by the message monitor.

Message Monitor is located in the dormant directory. This means that it is not available
from the Applications Menu or the Instance List.

To move Message Monitor from the Dormant directory:

Quit Studio 16

From WorkBench open the dormant directory, by clicking its icon.

Drag the Message Monitor icon on to the Application Directory Icon.

Delete the S:Studiol6Instance.config file.

Load Studio 16, Message Monitor will appear in the Applications Menu and the
Instance List.

b
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Meters

Name:
Keyboard:
Class:

Description:

Meters
AV
Application Module

This Module displays sound levels in much the same manner as the meters on a cassette
deck. Like a cassette deck, these meters are used to adjust the input gain of incoming
sound so you can get the maximum volume before clipping. Whenever you adjust the
input gain of a card you should open a meter window. This allows you to make an
intelligent decision about where the input gain slider should be set.

Another use of the meters is the visual monitoring of the sound going through each of
the Studio 16 channels. You can easily tell if a sample was recorded improperly by
looking at the level of a channel to see if it is too low or too high. You may decide that
a sample needs to be re-recorded.

I I

Figure 1. Meters

Layout:

Menu: Meters

Analog

The meter window can consist of an Analog Meter, a Digital Meter and a scrolling
graph. Each meter is assigned to a specific channel using the Channel Menu option.
Each meter takes up more blitter time, so slower systems should keep the number of
meters to a minimum.

For most applications, the gain information required can be derived from the digital
meters and the scrolling graph. Other than setting the input gain, meters are optional.
While they look nice, they also take up memory and a surprising amount of CPU and
blitter time. It is quite possible that if you close down the Meter module you will be able
to playback more channels.

Allows you the flexibility to show only the types of meters you require. Each meter
channel can display the volume information in up to three ways: an analog meter
simulation, digital meter simulation with peak hold, and a scrolling graph.

The analog meters use a waited averaging technique to show the average sample

amplitude. Large instantaneous peaks in a sample's volume will have only a small effect
on an analog meter's needle position unless they occur frequently. It is difficult to
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decide if a sample is clipping using this type of meter, so it is more useful to use one of
the other types of meters for adjusting the input gain of the card. '

Digital The digital meter shows the instantaneous peak of a sample's amplitude in a given
period of time. If a sample has one large peak this type of meter will display the peak.
If the right most LED is displayed, then clipping occurred. In most cases the input gain
should be reduced to prevent this. The peak hold feature shows the largest amplitude of
a sample for a longer period of time. This makes it easy to determine how loud the
peaks of a sample are.

Graph The scrolling graph meter is a type of meter unlike any analog world counterpart. It
shows the instantaneous peak of a sample on one axis while showing time on the other
axis. This type of meter is useful for determining the type of sound being played
through a channel as well as its amplitude. With practice you can tell whether a
channel is playing back a voice track, a sound effect or some music just by looking at the
shape of the graph.

Menu: Channels Allows you to assign meters to specific channels. Select the channels required. Input
should be selected to monitor the gain level before recording.

Note: To select multiple options in a sub-menu click the left mouse button while
holding down the right.

The maximum number of meters per meter module is four. To show more than four
meters, you must first close the Meter Window and launch Instance from the
Applications Menu. From Instance duplicate Meters. Now from the Applications Menu ‘
you can access Meters#2, this will provide four additional meters. For more meters,

duplicate Meters in Instance again.
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Name:
Keyboard:
Class:

Description:

Volume

Decibels

Mixer
M
Application Module

The mixer allows you to adjust the relative volumes of the playback channels and the
input and output volume. And, if the AD516 is installed, a pan adjustment is included
for each playback channel. The mixer uses the DSP chip to digitally adjust the volume
and pan of each channel. You should use the mixer to adjust a sample that is playing
back too loud or too soft or to make a sample playback on the left or right channel (or
both). The volume and pan may be changed before, after or during sample playback.
The mixer also displays the sample name currently playing through each channel.

Qutput

]

Figure 1. Mixer

To adjust the volume of a channel simply move the appropriate slider. The mixer will
display which sample is playing on which track. This makes it easy to identify which
volume slider to adjust. Use the output volume slider to adjust the volume of all the
channels. This is useful for fading in or out entire soundtracks. The input volume is
useful when you want to mix the card's playback channels with an external audio source.

Since the mixer works in the digital realm it is almost distortion free; however, care
should be taken to refrain from clipping a channel since clipping causes distortion.
Digital distortion is somewhat harsher sounding than analog distortion.

Note: Ideally, a channel should be maintained at +00dB where the dynamic range is
maximized. When you reduce a channel's volume digitally (as the mixer does),
you are also reducing the channel's dynamic range.

When recording from the Recorder or from the Transport Module in the Record Input
Mode, the audio input will be digitized regardless of the Mixer setting. Note on Figure
2, the Record Input Tap is before the volume adjustment on the Mixer. To record at
the output tap. You must use Transport and set the options to Record Output.

The Mixer specifies volumes in Decibels (dBs). Decibels are a logarithmic scale used

to more accurately represent how the ear hears volume changes. Zero dB means no
gain. Attenuation are negative, and amplifications are positive.
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For example:
-oodB is equivalent to no volume
-6dB is equivalent to 50% volume
0dB is equivalent to 100% volume
+6dB is equivalent to 200% volume

-0, or negative infinity is represented by -00dB in Studio 16.

Audio Track Track Track Track
IN 1 2 3 4
Rec Input
e
"
Rec Output
Tap
Audio
Q’- Volume Control on Mixer ouT
Figure 2. Mixer Diagram

Pan The pan adjustment allows you to vary the level of audio to playing on each channel.
The AD516 has two channels, and you can set a sample to play on either the left, right,
or both output jacks. When the pan slider is in the center, the sample will play equally
on both the left and right output. If the pan slider is all they way to the right, the sound
will only play on the right output. If the slider is all the way to the left, the sample will
play only on the left. You can also vary the levels on each output.

Stereo is accomplished by recording two tracks: one panned full left, and the other
panned full right. You use pans that are not full left or full right when playing back
mono tracks that you want to appear on both the left and right outputs.

NOTE: The AD1012 is a mono card and does not have a pan option. ]

Clip Indicator
The clip indicator is similar to the peak hold on the digital meter. It indicates when the
channel's volume clips. ’
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Scrolling Graph

Menu: Mixer

Similar to the Scrolling Graph in Meters. It is also possible that the mixer can load
down the system. This is true for any of the windows that responds to real time events.
If the system is too busy, Studio 16 may be limited in the number of simultaneously
playing channels. Closing the mixer window may increase the number of channels you
can play back. Or, you can try substituting Tiny Mixer instead.

Allows you to allocate a specific number of channels for the Mixer. Select the channels
required. Input should be selected to monitor incoming audio.

Note: To select multiple options in a sub-menu click the left mouse button while
holding down the right.
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ModList

Name:
Class:

Description:

Layout:

Procedure:

ModList
Application Module (Dormant)

The ModList, lets you load or unload code from disk and memory. If you have modules
that are not in your Instance list, but are on disk in your Application, Utilities, or
Drivers directories, you can use ModList to load the module. After you have loaded the
module it will be listed in Instance. You can load a module multiple times to create
multiple instances.

NOTE: The ModList will not be used by most users. It is included for advanced users
or for those rare occasions that require its use.

Figure 1. ModList (Module Librarian)

In the ModList, the left list contains modules on disk in your Applications, Utilities, or
Drivers directories, see Figure 1. The right list contains modules that are currently in
RAM. Double clicking an entry in the left list (the "on disk" list) will cause the module
to load into RAM. Generally the loaded window won't open unless you select it in the
Instance List. Double clicking an entry in the right list (the "in RAM" or "Resident"
list) will cause the module to unload itself. However, its "instance" will remain in the
Instance List until removed.

Move ModList from the Dormant directory

Quit Studio 16.

From WorkBench open the dormant directory, by clicking its icon.

Drag the ModList icon on to the Application Directory Icon.

Delete the S:Studiol6Instance.config file.

Load Studio 16. ModList will appear in the Applications Menu and the Instance
List.

il e
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Open List

‘ Name:
Keyboard:

Class:

Description:

Gadget:

Open List
~O
Application Module

The Open List contains lists of your samples by directory. You can play, rename,
delete, and edit, from Open List, Figure 1. Launch the Open List by selecting it from
the Applications Menu, or type ~ O.

A sample in the Open List is a digitized sound on your hard disk, that you have recorded
or loaded. Since Studio 16 always works with files on the hard disk, it is a little
different from most programs. For example, there is no need to save each sound before
you quit. If you quit Studio 16, then re-run it later, all your "open" sounds in the open
list will still be there. Of course, if you have your samples in RAM:, your samples will
be lost when you turn off your Amiga unless you save them to disk.

All the samples in the Open List are draggable to the Cue List and Transport. As are
the regions that can be displayed in Open List, (activate Show Regions).

All the Open List Menu options can be executed on multiple samples. Select multiple
samples by holding down the shift key, and clicking on the Samples' names.

1]  Open List | -
r

Figure 1. Open List

Record Path

The record path is the directory where samples will be recorded to. It is indicated by an
active box (IX] )next to the Directory name. To change the record path, add another
path and then click the active box next to the new directory's name.
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Menu: Open List

Play Sample
Select this option to play a sample. Select multiple samples by shift clicking. When
playing back multiple samples, the sampling rate must be the same for all samples. The
ADS516 is limited to 8 simultaneous samples, the AD1012 is limited to 4.

ADS516 ONLY - A stereo sample will appear in the Open List as two samples, like:
Untitled_L, and Untitled_R. Play both channels by selecting both
samples in Open List. Shift clicking will enable you to select both of
them, hit 4-P to play.

To adjust the volume and pan of samples while they play, load the Mixer from the
Applications Menu and make level adjustments in realtime.

Stop Playback
To stop playing sounds, select the Stop Playback option.

Rename Sample
The Rename option allows you to change the name of samples in Open List. Select one
or more sample names so that they are highlighted. Select the Rename Samples option.
For each sample selected, a requester will appear asking you to type in the new name for
the sample.

Delete Sample
To remove a sound permanently from your hard disk and the Open List, select its name
in the Open List then select the Delete option. This will delete the file.
CAUTION: There is no way to recover a deleted sample.

Convert Sample
This option allows you to convert the file format of a sample to an alternate format.
Once a Studiol6_2.0 sample has been converted to another format, it can still be
accessed by Studio 16, but any region parameters and/or SMPTE start times that were
associated with it may be lost.

When converting files to eight bit formats, you will decrease the size of the file size by
half, and you will also lower its fidelity. However, if you are working with samples that
don't require a high Signal-to-Noise Ratio, (e.g. explosions, crashes. etc.) converting
them to an 8 bit format will save disk space and still allow you to play them
simultaneously with your 16 bit samples, assuming they were recorded at the same rate.

Available formats are:

Studio 16_2.0 - Studiol6_2.0 is a 16 bit format, similar to AIFF, but it appends special
data that keeps track of non-destructive edits and regions. Note that even though the
AD1012 records with 12 bits of resolution, it stores files using 16 bits.

Studio16_1.0 - The original Studio 16 format.

AIFF 16 bit - This is a standard file format for 16 bit files. Studio 16 edits, loads, and

saves sounds with 16 bits. AIFF is very common on the Macintosh, and is used by some
Amiga software. AIFF does not remember regions or non-destructive edits.
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AIFF 8 bit - This is an AIFF format that only uses 8 bits. If you convert to this format,
you will lose some sound quality since you are dropping bits. However, the file's size
will be reduced by about half.

IFF 8SVX - This is a very common Amiga format for 8 bit samples. Files convert to
this format can be loaded into 8 bit sound editors, such as Perfect Sound or Audition 4.
If you convert to this format, you will lose some sound quality since you are dropping
bits. However, if the file is a sound effect you may not notice the decrease in fidelity,
and the file's size will be reduced by about half.

RAW - This stores raw sample data in two's complement binary form. The first
sample will be in the first word of the file (each sample is 16 bits), the second sample
will be in the second word (third and fourth bytes), etc. This format is not generally
recommended, except perhaps for use by programmers who want a simple file format to
load.

CDTV RAW - This format is only of use to developers with the CDTV emulator. This
format will create a stereo CDTV raw audio file by duplicating mono data on the left
and right channels.

Edit Sample
Selecting a sample name then the Edit option will bring up the sample in an editor. See
the Edit Reference Section for a more complete description.

Add New Path
Select this option to add another directory to the Open List. This is especially useful if
you are working with multiple hard drives or you have samples organized into multiple
directories. When selected, a path requester will appear allowing you to select a new
path. Click OK to update Open List. A maximum of eight directories can be listed at
once.

Remove Path
Select Remove to bring up a Remove Path requester.

Update Path
Selecting this option will update the current directories in the Open List. This is
especially useful if you are using a removable media drive like SyQuest, and you change
cartridges, or if you are copying files from DFO0 and you change disks.

Show Regions
When activated, a region list will be added to the right of your paths. The region list
will display the regions that have been selected for a specific sample. Select a sample
with regions, and they will be displayed in the region list.

87



Module Reference

88



Preferences

. Name: Preferences

Keyboard: AP
Class: Application Module
Description: Preferences is located in the Project Menu. It is dedicated to customizing the

appearance and performance of Studio 16. Included in Preferences are: Interface
Options, SMPTE source, Memory Options, and the default Record Format.

Preferences

INTERFACE
N . 2 CAEECd T | I~ l ) &

I B | g =
=
N A ' =

MEMORY :] r RECORD FORMAT

Figure 1. Preferences

Layout: The Preferences window is divided into four sections: Interface, SMPTE, Memory and
Record Format.

Gadget: Interface -

Color Boxes and Sliders
Click on a Color Box to select which color to adjust. Slide the knob on the red,
green and blue sliders to adjust the color. The affected areas will update as you
adjust the slider. Click Save Setup in the Project Menu to have Studio 16 use the
new colors on loading.

Preset Drop ListClick on the { to view a list of preset screen colors. Use the scroll bar and arrow
buttons to scroll through the options. Click a selection to make the Studio 16 screen
update using the new colors.

Interlace By selecting Interlace, your screen will double in vertical resolution resulting in a
larger work area. Running an Amiga 2000 in Interlace mode without a flicker fixer
may result in an undesirable flicker.

To activate the Interlace mode, you must select Interlace, select SaveSetup from the
Project Menu, Quit Studio 16, and then restart the program.

ClickToFront  Activating this button will allow you to bring windows to the front by simply
' clicking anywhere on them. If it is not selected, you bring a window to the front by
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SimpleTitleBar
Gadget: SMPTE -

SMPTE Source

SMPTE Rate

Gadget: Memory -

clicking the Depth Gadget in the title bar of windows, or by calling them to the
front with the keyboard shortcut. ‘
This button will cause the Close, Minimize and Depth button to only show in the

active window. All non-active windows will only display the module name.

Click on the droplist to select your default SMPTE source. The recommended
setting is either AD516#1 or AD1012#1. This will set your default Source to your
External SMPTE; however, it will be overridden to SMPTE gen when you open
SMPTE Generator. Closing SMPTE Generator will cause Studio 16 to revert to
your default setting, (e.g. AD516#1).

By selecting 24, 25, or 30 Frames per Second, or DF, you select which SMPTE
Time code format to be used by the SMPTE Monitor and Generator, Sample Editor
and Cue List Module. DF is 30 fps, drop frame. '30" is non-drop frame.
The common applications for the available formats are:

24 Motion Pictures

25 European Video

30%* USA B&W Video and Music

DF USA B&W Video and Music
*If you are using 29.97 non-drop frame, select 30 fps.

For more information on the various SMPTE formats see Chapter 5 - SMPTE.

Use Extended Memory

If selected, this button causes Studio 16 to try to allocated channel buffers in
extended memory first, followed by AutoConfig fast RAM, and lastly chip RAM. If
it is NOT selected, this will prohibit Studio 16 from allocating channel buffers in
extended memory. This button only effects channel buffers.

You SHOULD select this button if your hard disk controller and '030/'040 card
are on the same PCB. (e.g. You have a stock A3000, or You have a GVP 030
card with built in hard disk controller.)

You SHOULD NOT select this button if you have an '030 or '040, but your
hard disk is on a stand alone Autoconfig card. (e.g. You have a GVP series II
DMA hard disk controller and a PP&S 040 card with 32 bit RAM.)

Your Amiga has two major types of memory: Chip and Fast. Chip memory is
directly accessible by the Amiga's graphics chips. Fast memory is not directly
accessible by graphics chips, but can be accessed faster than Chip memory.
And, there are roughly two different kinds of Fast RAM:

Extended Memory is fast RAM that is only accessible by the 32 bit 68030 or
68040 processor. It lies in address $FFO00000 to $SFFFFFFFF. .

90



Preferences

Zorro II AutoConfig Memory is fast RAM that can be accessed by a standard
Zorro II AutoConfig card. It is also referred to as "24 bit" or simply
" Autoconfig" memory.

Studio 16 allocates "Channel Buffers" in RAM when playing a sound. Data is
buffered there on its way to or from the hard disk. For efficient data transfer, DMA
hard disk controllers need direct access to these buffers. This means that if you
have a Zorro II AutoConfig DMA hard disk controller, your channel buffers can not
reside in extended memory. This is because AutoConfig cards can not DMA into
extended memory.

Channel Buf  The Channel Buffer specifies how much RAM you want to use for buffering each
sound that plays back. When playing back multiple sounds simultaneously, a
channel buffer is allocated for each playing sound.

If you have less than 3 MB of RAM, reduce the default channel buffer size from
256K to about 64K. You may want to increase the default channel buffer size if you
have a slow hard disk, or you encounter "skipping" while playing sounds. See the
Chapter 7 - Troubleshooting for more information on skipping.

Keep in mind that one channel buffer is allocated for each playing sample. Make
sure you have enough system RAM to cover your requested buffers. The chart
below lists the RAM used by a specific number of playback samples. For example,
if you plan to play four simultaneous tracks with the channel buffer set to 4096K,
you will need 16,384K (or 16 MB) of free RAM just for buffers.

This same chart will calculate the RAM used by Cue List for a specific number of
preloads. The number of samples to preload is set from the Prefs in the Cue List
Menu.

The default setting (256K) is adequate for most systems.

Channel RAM Usage by a Specific Number of Tracks
Buf Size Playing Simultaneousl
1 2 3 4 5 6 7 8

128 0.iMB| O3MB| 04MB| OSMB| O6MB| O08MB| O9SMB | 1.0MB
256 o3MB| o5MB| O8MB| 1O0MB| 13MB| 15MB| 18MB| 2.0MB
512 05MB| 10MB| 15MB| 20MB| 25MB| 3.0MB| 3.5MB| 40MB
1,024 10MB| 20MB| 30MB| 40MB| 50MB| 60MB| 7.0MB | 8.0MB
2,048 20MB | 40MB| 6.0MB| 80MB | 10.0MB ( 12.0MB | 14.0MB | 16.0MB
4,096 40MB | 8.0MB ( 12.0MB | 16.0MB | 20.0MB | 24.0MB | 28.0MB | 32.0MB

Figure 1. Channel Buffer Size required for Number of Simultaneous Tracks

Copy Buffer Size The Copy Buffer specifies how much memory to use in many Edit, Save, and Load
operations. The larger the CopyBuffer, the quicker these operations will occur.
The default is 32K. (This setting is not related to the CopyBuffer sample created
during destructive edits.)
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Gadget:

Record Format -

Studio 16_2.0

Studio16_1.0

AIFF 16 bit

ATFF 8 bit

IFF 8SVX

CDTV RAW

Record Path -

Free -

When a sample is recorded it is usually stored in the Studiol6_2.0 file format. This
default format is selected in Preferences. If your file is to be exported to another
sound program you can convert it to another file format in Open List. You can also
record it direct to disk in that format.

When converting files to eight bit formats, you will decrease the size of the file size
by half, and you will also lower its fidelity. However, if you are working with
samples that don't require a high Signal-to-Noise Ratio, (¢.g. explosions, crashes.
etc.) converting them to an 8 bit format will save disk space and still allow you to
play them simultaneously with your 16 bit samples, assuming they were recorded at
the same rate.

Available file formats are:

Studiol6_2.0 is a 16 bit format, similar to AIFF, but it appends special data that
keeps track of non-destructive edits and regions. Note that even though the
AD1012 records with 12 bits of resolution, it stores files using 16 bits.

The original Studio 16 format, similar to Studio16_2.0 but will not support regions.

This is a standard file format for 16 bit files. Studio 16 edits, loads, and saves
sounds with 16 bit files. AIFF is very common on the Macintosh, and is used by
some Amiga software.

This is an AIFF format that only uses 8 bits. If you record in this format, you will
lose some sound quality since you are dropping bits. However, the file's size will be
about 50% smaller.

This is a very common Amiga 8 bit digital sound format. Files recorded in this
format can be loaded into 8 bit sound editors, such as Perfect Sound or Audition 4.
If you convert to this format, you will lose some sound quality since you are
dropping bits. However, if the file is a sound effect you may not notice the decrease
in fidelity, and the file's size will be reduced by about half.

This stores raw sample data in two's complement binary form. The first sample will
be in the first word of the file (each sample is 16 bits), the second sample will be in
the second word (third and fourth bytes), etc. This format is not generally
recommended, except perhaps for use by programmers who want a simple file
format to load.

This format is only of use to developers with the CDTV emulator. This format will
create a stereo CDTV raw audio file by duplicating mono data on the left and right
channels.

Is selected in the Open List. A display is shown in Preferences.

The displayed number next to Free: is the number of available megabytes in the
selected record path.
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Quit

Name: Quit
Keyboard: Q
Class: Project Module

Description: Select Quit, from the Project Menu when you want to end your Studio 16 session. A
requester will appear to verify you want to quit. To save the current window
arrangement and Preference settings, select Save Setup from the Project Menu before
quitting.

NOTE: If you have recorded into RAM, be sure to move your samples to hard disk
before turning off your Amiga.
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Realtime Delay

. Name:
Keyboard:

Class:

Layout:

Description:

RealtimeDelay
D
Application Module

The Realtime Delay allows Studio 16 users to process audio in real time using the DSP
on board. The modulation delay combines the controls of a standard delay with delay
modulation parameters more commonly found on effects boxes such as flangers. These
controls allow you to create numerous effects including delays, choruses and flanges in
realtime. Realtime, refers to audio as it plays through the AD516 or AD1012, not
samples playing from hard disk.

NOTE: This module takes over Studio 16. This means that no other modules will work
and no other audio may be played back while the card is in this mode.

Several different effects can be obtained by altering the parameters of the modulation
delay. The two most common effects are delays, and flanges.

Delay: Delays and echoes are achieved by having a delay time of at least 3<ns1:XMLFault xmlns:ns1="http://cxf.apache.org/bindings/xformat"><ns1:faultstring xmlns:ns1="http://cxf.apache.org/bindings/xformat">java.lang.OutOfMemoryError: Java heap space</ns1:faultstring></ns1:XMLFault>